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EasyEDA Editor：https://lceda.cn/editor

EasyEDA Desktop Client：https://lceda.cn/download

 

Remark

This document will be updated as the new features of the editor are updated.
The latest revison please refer at EasyEDA Tutorials.pdf

 

https://easyeda.com/editor
https://easyeda.com/download
http://club.szlcsc.com/article/details_40947_1.html
af://n36


Editor FAQ  

Please spend a few minutes reading this FAQ, it will save you lots of time getting started with 
EasyEDA.

Video Tutorials  

https://www.youtube.com/channel/UCRoMhHNzl7tMW8pFsdJGUIA/videos

Contact Us  

https://docs.easyeda.com/en/FAQ/Contact-Us/index.html

Update Records  

Update Records

Can I use EasyEDA in my company?  

You are free to use EasyEDA for individuals, business and education.
If you add our Logo and link on your PCB/Video we will appreciate.

I don't like others seeing my design. How can I stop
that happening?

 

Set your project as Private. For extra security you can even save your work locally.

What happens if EasyEDA service is offline for some
reason?

 

EasyEDA can be run as an offline application.

Is EasyEDA safe?  

There are no absolutely secure things in the world but even if you have the misfortune - as 
happened to one of our team - of losing one laptop and having two hard drives break, 
EasyEDA will try to protect your designs in following ways:

1. We utilize SSL throughout the entire domain EasyEDA.com. Secure Socket Layer (SSL) 
technology encrypts all data transferred between your computer and our servers. Your data 
is for your eyes only.

2. You can save your files locally.
3. Multiple copies of every file are saved in your local database. 
4. EasyEDA servers backup your designs frequently.

What if EasyEDA cannot become self sustaining and
has to close down?
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We promise to do our best to ensure that neither of these things will happen; we have spent so 
much of our time to get to this point. We promise that if we cannot make enough money out of 
EasyEDA to keep it alive or to fund further development, we will not simply abandon our baby or 
our community but we will consider donating the code to the Open Source Community to let 
them build on our efforts. There are no companies who can stay forever, so if a time comes when 
we have to close down,  we will follow the steps below:

1. Give our users six months warning prior to closure;
2. Ensure all our users can backup their designs;
3. Ensure that user's designs can be exported to some other EDA tools, such as Kicad, Altium 

Designer and others.
4. Package our codes, so that users can install an EasyEDA in their own OS (Windows, Linux, 

Mac). Users can then build their own cloud EDA.
5. Upload our codes to github.com and make them open source.

So, nothing will be lost and our users can continue to enjoy an awesome web based EDA tool that 
lets them stay in charge of their designs: anywhere, anytime and on any OS.

How to find the list of hotkeys.  

Please refer at Introduction: Shortcut Keys

Where are my files?  

Your files are stored on EasyEDA servers, so you can access them anywhere and share them with 
your partners.

How to save my file to the local?  

You can download the project via :

Right-click project and download; 
Download the EasyEDA source
Export to Altium file Export: Export Altium

Why does EasyEDA focus on Cloud based EDA?  

EasyEDA is built for people who like to work anywhere, who like to build projects together with 
other team members, who like to share their projects, who like something that operates like a 
github for hardware design. The only way to meet these needs is to build a Cloud version EDA.

How can I work if there is no internet?  

Although most of the time there are ways to access the internet easily and cheaply there may be 
times when, for whatever the reason, internet access is simply not possible. For times like this, 
EasyEDA is working to provide a desktop client soon.

Does EasyEDA have a desktop version?  

Yes, please refer at: https://easyeda.com/page/download

Which Browser is best for EasyEDA?  
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  Chrome and Firefox. If you are restricted to using other browsers, it would be better to 
download the EasyEDA desktop client.

How to go to your dashboard.  

In the User Center, you can check all your Projects, Modules, Libraries and Friends, Messages etc.

There are two ways to arrive there.  

1. From the Editor, you can click on the EasyEDA logo or user logo:

2. From the homepage, you can click My Projects:

 

How to delete a project.  

Select it and right click to open a context menu, like the image below.

How to delete a schematic or PCB.  

Select it and right click to open a context menu, like the image below.
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How to share a project with others.  

1.Make your project public.
Open https://easyeda.com/account/user, move the mouse to the project cover, there is a share 
icon, click it to share.

  

2.To share a project privately with only selected collaborators via:
Add Member   

How to find the version history of schematics and
PCBs.

 

The version history of your EasyEDA schematics and PCBs can be accessed by right-clicking on 
the file you wish to query to open the context menu as shown in the image below: 

  

Then click on the version number that you wish to view.

Note: saving a previous version will restore that version to being the current version of the file.

af://n116
https://easyeda.com/account/user
https://docs.easyeda.com/en/Share/Add-Member/index.html
af://n119
af://n125


If I update the schematic, how do I then update the
PCB?

 

The initial conversion of a schematic to PCB is done from within the Schematic Editor using the 
Convert Project to PCB...  button as illustrated in the toolbar below but a new Update PCB  
button has been added so that modifications to the schematic can immediately be passed 
forward to update a selected PCB without having the PCB editor window already open. 

 

Alternatively, you can import changes from the schematic from within the PCB Editor:

https://docs.easyeda.com/en/PCB/Import-Changes/index.html

How to rename a Sheet/Document or modify
description.

 

In this menu, there is a Modify  option, so you can rename your files.  Double click or right-click 
the sheet tab can change the sheet title too.

How to find components/parts/libraries?  

The component search function has been significantly improved to make finding part symbols 
and footprints quicker and easier. Press SHIFT+F  or click on the Libraries  icon on the left 
navigation panel: 
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In the new components dialog, it is easy to select the right components via tags and you can set 
tags for your own components.

How to add sub parts to a schematic.  

You can add sub parts to a schematic one by one but please note that the sub parts prefix must 
be in the form of U1.1 U1.2 etc, and not U1.A U1.B.

What is the unit of the schematic sheet? How to
change schematic unit?

 

The basic unit of the schematic sheet is the pixel. 1 pixel is about 10mil (0.001 inch) but please 
note that this use of the pixels as a unit in a schematic is just for reference.

For a complex project, I want to split the schematic
over several sheets. Does EasyEDA support
hierarchy?
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EasyEDA don't support hierarchy, but support multi-sheets。
Please check out this link https://docs.easyeda.com/en/Schematic/Multi-Sheet/index.html

How to change the sheet size and modify the design
information.

 

To change the sheet size, move the mouse anywhere over the lower right area of the drawing 
border or frame until the whole border highlights red and then right-click on it. Paper size and 
orientation can then be changed in Sheet Attributes  in the right hand panel.

To modify the design information, left-click on the relevant blue text in the lower right area of the 
drawing border or frame to change it in Text Attributes  in the right hand panel.  Double left-
clicking the blue text will allow you to type new information directly into the field. 

 

How to create a schematic library symbol.  

Document > New > Schematic Lib
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How to tag my schematic library symbol.  

After creating the library and saving, you can add a tag for it:

and you can add and edit the tag at "Libraries":

 

How to create sub parts for multi-part components. 
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In My Parts, Right click the part then select Add Sub Part from the menu that opens:

   

How to change the footprint for a component.  

https://docs.easyeda.com/en/Schematic/Footprint-Manager/index.html

How to change the Units of PCB from mil to mm or
inch.

 

There is an option for that in PCB canvas attributes: 

 

How to pick and move the components on the PCB
canvas quickly.
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Before routing the PCB, the components need to be positioned in suitable places on the PCB. In 
the PCB Editor, it can sometimes be quite difficult to select components by clicking on the 
silkscreen outline or the pads. To select and move them more easily, please use drag mode (Hot 
Key D ) or click the Move  icon in the PCB Tools toolbar:

     

How to add test point in schematic or PCB?  

Schematic: You can place a single pin connector from EElib, and then update its footprint.

PCB: You can place a top/bottom layer pad , and then route it with track.
  

How to indicates low electronic level in the
Schematic Pin or Netlabel

 

You can add a #  characater in the pin name/netlabel last text. You can use symbols that you are 
familiar with. You do not have to add a line above the netlabel name. 
  

Can I create a PCB without creating schematic?  

Yes but for any but the simplest PCBs, please see:

https://easyeda.com/forum/topic/The_best_way_to_design_a_PCB_in_EasyEDA-ThR3pwqIC

How to add more fonts for PCB.  

You can refer to Text of PCB section.

How to insert an Image/Logo to PCB.  

You can refer to Image of PCB section.

How to insert a DXF board outline.  

You can refer to Import DXF File of Import section.

How to create non rectangular pcb outline such as
round?

 

You can import a DXF file for the board outline. For a round board outline, you can use an arc to 
do that, you just need to change to the board outline layer, then draw 1 arc like in the image 
below (need to adjust a bit later), you can use lines and arcs to create complex board outlines.
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How to add a slot and cut out.  

Please use solid region https://docs.easyeda.com/en/PCB/PCB-Tools/index.html#Solid-Region

Or draw a track and right-click it, use the "Convert to NPTH" option.

How to measure dimensions on a PCB.  

https://docs.easyeda.com/en/PCB/PCB-Tools/index.html#Measure-Dimension

How to add more layers.  
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Click the layer options button, then tick the extra layers in the dialog that opens. 
https://docs.easyeda.com/en/PCB/Layers-Tool/index.html

How to add solder mask aperture.  

It is possible to get boards with the copper exposed so that you can apply a layer of solder over 
those tracks to further increase their current carrying capacity. In this case, you need to add 
solder mask over a copper (copper area, track, solid region). 
EasyEDA will add solder mask for pads automatically. Sometimes however, you may need to add 
an aperture in the solder mask to expose and area of copper.  
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1. First, add a top or bottom solder mask layer, as required.

   

2. Next, draw a region in the solder mask layer over a copper item as illustrated in the image 
below. This in effect draws an aperture in the solder mask so that the copper item inside the 
region, in this case the track, will be not be covered by the green film of solder mask.

A common mistake is to just draw a solder mask, without a copper area, like the track pointed to 
by the yellow arrow. That is incorrect and does not produce the desired result.

Or you can click the track, and then click the Expose Copper  button at the right-hand panel.

How do I set the dimensions of my PCB in the
layout?
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PCB's dimension/size depends on the board outline, you can create your board outline, please 
refer to Board Outline of the PCB section.

My PCB is complex, how can I be sure that I have
routed all of the tracks?

 

Please refer to Design Manager of PCB section. 

I need to start my layout again, how can I remove
all of the tracks?

 

You can use Unroute All and Global Delete under the Edit menu.

How to put a component on the bottom layer?  

There are two ways to do this.

1. If your active layer is the bottom layer, then every component you place will be placed on 
the bottom layer automatically.

2. You can place a component then select it and change its layer attribute to Bottom layer  in 
the right hand panel.

I can't convert schematic to PCB. Why is this?  

1. You have not set the right footprints for your components. 
2. Prefix Conflict Error
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3. Invalid footprints

How to create a PCB footprint.  

  

How to change a component's footprint?  

When you create a SechamticLib, you can set the footprint for it at the right-hand panel.
When you at the schematic, you should select the component and click the footprint input box at 
the right-hand panel. and change it at Footprint Manager
When you want to change the schameticLib's footprint which was you had created, at "Libraries", 
select the schameticLib, and click Edit button, click the footprint input at the right-hand panel, the 
footprint manager will show up, you can search or select the footprint and then update it, and 
then save the SchematicLib.

How to panelize the PCB  

Please refer at PCB: Panelize

What does Warning copper area do not allow self
intersection

 

Please refer at Forum: What does Warning copper area do not allow self intersection
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Keep in Mind  

1. There is no need to back up your schematics and PCBs manually. After the first save of any 
file, EasyEDA will back up all saved files automatically under the Version History. If you want 
to back up your files locally, you can download a copy of the whole project or of individual 
files in a project in EasyEDA Source (JSON) format:

and Document > EasyEDA Source > Download

2. If you need help, you can contact us support@easyeda.com  or ask via our Support Forum; 
we will respond ASAP.

Most Common Errors on EasyEDA.  

1. Manually creating backup schematics into the same project. When a project is converted to 
PCB, EasyEDA will merge all of the schematics under the same project into a single PCB. If 
there are multiple copies of the same schematic in a project then this will create errors such 
as duplicate part prefixes. Especially if you are new to EasyEDA, just keep one copy of each 
unique schematic in any one project. 

2. Saving schematic and PCB into different projects. Unless you are absolutely sure that you 
will not need to update (Synchronise) your PCB from changes made to your schematic then 
please keep the schematics and PCB under the same project.

3. Bad footprints. Schematic symbols must have the appropriate footprints assigned to them, 
these footprints must exist in the library, and for any footprint that you have not created 
yourself, you must have clicked on the Favorite option in the component search window to 
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add it to your Favorite Parts list in the left hand Navigation panel.

4. Using the polyline from the Drawing Tools Palette to connect symbol pins. To connect 
components together, you must use Wires from the Wiring Tools Palette.

Spice Simulation FAQ  

EasyEDA's main target is schematic and PCB, not simulation. EasyEDA only support simple 
schematics simulation.

How to set the resistance of a resistor  

   You can use the name attribute. Just set the name or double click the value text.
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Where Can I find the Probe/voltage probe?  

  Voltage probe 

   

Why I can't simulate my schematic  

   EasyEDA only has very few simulation models, EasyEDA is powered by 
http://ngspice.sourceforge.net/ please check Ngspice to know what can be simulated.

 

Does EasyEDA canvas use the Cartesian coordinate
system?

 

 Yes and no. 

 It uses X and Y coordinates where the horizontal X coordinate is positive to the right of the origin 
and negative to the left but the vertical Y coordinate is positive below the origin and negative 
above it. 
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 Actually, we think our coordinate system is not very good but it is hard to change. 

  

How to update editor to latest version  

Version Rule

EasyEDA version number is ReleaseYearCount.ReleaseMonth.ReleaseCountOfThisMonth . For 
example, v4.9.3 is the fourth year release of EasyEDA, and at the ninth month of this year, 
EasyEDA had released 3 times.

Version Upgrade

If you use EasyEDA online, it can seamlessly upgrade by itself. However,EasyEDA uses an App 
Cache technique to allow you to use EasyEDA offline (W3C HTML5 Offline Web Applications) 
which may delay the automatic upgrading process. Therefore, if you want to upgrade to the 
latest version immediately, you can follow the two simple steps below.

1. Check the About... dialog; 
2. If the Built Date is older than 2017/06/01:

Close your browser open EasyEDA again.
If the Built Date is still showing older than 2017/06/01:
Close your browser and open EasyEDA again.
If the Built Date is at or newer than 2017/06/01, you don't need to do anything.

Note: 2017/06/01 is just an example.  

If those two steps don't work, you may need to clear your browser's cache:

1.Mozilla Firefox  

Close the editor, Go to “Preferences… > Privacy & Security > History > clear your recent 
history” or use Ctrl+shift+Delete,
Click on “Clear now”,
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Reload easyeda again.

  

2.Chrome  

Close the editor, Open the following URL: chrome://appcache-internals/

Look for easyeda.com and click “Remove”  
Reload easyeda again.

 

 



Or you can use Ctrl+shift+Delete to delete Chrome caches.

 

How to Order PCB  

1. Before ordering, please check this Gerber first: 
https://docs.easyeda.com/en/PCB/Gerber-Generate/index.html#Gerber-View

2. Visit and login at https://jlcpcb.com/quote
3. Add this Gerber file(compressed file) on the page and type the order options
4. Save to Cart, and then submit the payment

If you want to combine the components order with the PCB order at https://lcsc.com , please 
refer:
https://support.lcsc.com/article/24-do-you-offer-combine-shipment-with-pcbs

   

   

Essential Check  

Essential Check Introduction  

By following - and constantly checking against - a set of procedures, it is possible to avoid just 
about all of the common mistakes and omissions that can significantly delay or even stop a 
schematic being successfully converted to a PCB and then that PCB being successfully updated 
from the schematic as a design progresses.
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It can also significantly reduce the likelihood of a PCB being made that subsequently is found to 
not work correctly due to mistakes made during the creation of the original schematic (Schematic 
Capture). 

After spending hours on Schematic Capture, it is very frustrating to be presented with error 
messages about prefix conflicts, missing or invalid footprints when first attempting to pass a 
schematic through to the PCB Editor by clicking on the Convert Project to PCB… button or, after 
making changes to a schematic, similar error messages or having components that disappear 
from the PCB when attempting to update an existing PCB using the Update PCB… button in the 
Schematic Editor or the Import Changes… button in the PCB Editor. 

These issues can be avoided by running through a series of checks for the first time each new 
Part (i.e. the first instance) is placed into the schematic.

There are several other issues that arise from mistakes in and omissions from the schematic that 
people encounter only after they are part way through a PCB design or - worse still - only when 
they receive their PCBs in the post.

Almost all of these other issues can be avoided by running through a further series of checks (i) 
during Schematic Capture, (ii) once Schematic Capture is complete but before first attempting to 
convert the schematic into a PCB and (iii) when updating the PCB as work progresses.

This document pulls together all the essential procedures to follow and things to check in the 
schematic before clicking on the Convert Project to PCB…, Update PCB… or Import Changes… 
buttons.

Things to understand before using this document.  

Before using the document it is important that the following points are clearly understood:

What constitutes a Part in a schematic and a PCB?  

A Part is any element of the circuit that is to be mounted on the PCB plus any element which is 
ultimately intended to be mounted on or form an integral part of the PCB such as heat sinks, PCB 
mounting holes, mounting holes for PCB mounted potentiometers and switches (for example 
where a PCB is used as a front panel or as a self-contained test jig), test points, wire links or 
jumpers, fuse holders and even image based elements such as high voltage warnings and logos.

Note that fuses that are fitted into PCB mounted fuse holders are best dealt with in a schematic 
by showing the fuse using a fuse symbol in the schematic but assigning to that fuse symbol the 
BoM information - including the footprint - that is for the required fuse holder. The required fuse 
ratings, type and supplier information can then be included in the BoM using Add new parameter 
function.

Other socketed devices can be treated in the same way.

What is the relationship between Parts, Schematic Symbols
and PCB footprints?

 

Any Part must have a Schematic Symbol to represent it in the schematic (a.k.a. Schematic Lib) 
and that Schematic Symbol must have a PCB footprint (a.k.a. Footprint) assigned to it either when 
the symbol is created or after placing the first instance of it into the schematic. 

The associated PCB footprint must exist in the library.
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Ensuring that every Part has a Schematic Symbol with a PCB footprint associated with it and 
that that PCB footprint actually exists in the Parts (SHIFT+F) library will avoid a Missing 
footprint error being issued on Conversion or Update to PCB.

It is possible that a component may comprise more than one device in a footprint, for example 
logic gates. Some symbols represent both devices in a single symbol but quite often a separate 
symbol is used to represent each of the devices. This may mean that some of the pin numbers 
and/or names on the symbols representing each of the two devices may be different although 
both may have the same power and ground pin numbers and/or names.

High pin count devices such as processors and FPGAs may be split into several symbols 
representing different sections or ports. It is important to ensure that pin numbers and names 
are unique across all the symbols.

It is possible that a component may be available in different footprints. For example the LM358-N 
dual operational amplifier is available in several different footprints. The pin numbering and/or 
naming of the symbol may be different depending on which footprint the component is supplied 
in.

It is easy in EasyEDA to change the pin numbering and/or naming for a Schematic Symbol (using 
the I  Hotkey) or a PCB footprint so it may be tempting to think of an LM358-N as the same part 
in a different footprint and just put down a symbol, edit the footprint assigned to it and then 
hack the pin numbers and names about until they match the PCB footprint.

However, an LM358-N in a SOIC-8 footprint has a different pinout, a different part number and 
has to be physically ordered as a different part from an LM358-N in a DSBGA-8 footprint.

They are therefore two different  Parts. 

When thought of like this it should be clear that there should be one Schematic Symbol (or pair if 
each device has a separate symbol) and a matching PCB footprint for an LM358-N in a SOIC-8 
footprint and another Schematic Symbol (or pair if each device has a separate symbol) and a 
matching PCB footprint for an LM358-N in a DSBGA-8 footprint.

Ensuring that the pin numbers/names of the Schematic Symbol for a Part are correct, 
unique and match those of the PCB footprint associated with that particular part will avoid 
the generation of the Invalid footprint error being issued on Conversion or Update to PCB.

Why do Parts in a PCB disappear when the PCB is updated
from the schematic?

 

It is important to understand that any Part that is supposed to form part of or be mounted on 
the PCB must have a corresponding Schematic Symbol in the schematic. 

If it does then as soon as the PCB is created, the PCB footprint for that Part , even such a 
seemingly abstract item as a mounting hole, warning sign or a logo, will be pulled into the PCB 
layout without having to be added to the PCB later by hand.

If it does not then not only will the PCB footprint for that Part not be pulled into the PCB layout as 
it is created but when it is added to the PCB later by hand and the PCB is then updated to bring in 
changes made to the original schematic, that PCB footprint will be deleted.

Such elements can be added to the schematic later and then imported into the PCB but if they do 
not exist in the schematic at the time the PCB is updated from that schematic then they will 
always be deleted and will therefore have to be added back to the PCB by hand.
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What is the relationship between User Contributions and
the other Parts categories (LCSC (Official), Assembly LCSC
Components, System Components, My Parts, My Modules
and Common Modules)?

 

Any Schematic Symbol or PCB footprint chosen from the User Contributed category MUST be 
added to your local library by doing:

Libraries (or SHIFT+F) > Search for and select the part then > More > Add Favorite/Clone

Failure to do this will result in the footprint not being found and a Missing footprint error 
being issued on Conversion or Update to PCB.

footprints in the other library sections will be found automatically.

Note however that although Schematic Symbols and PCB footprints created by a user within a 
Team will automatically appear in that user’s My Parts library, once that user swaps to another 
Team, those parts will no longer appear in their My Parts library but will only be available via the 
Add Favorite option from the User Contributions library.

Procedures and Checklist  

Verify that the Schematic has been drawn to show clearly how the components in the circuit 
are connected together;  

The schematic must help the reader understand signal and power flow in the circuit with inputs 
on the left, outputs on the right, positive supplies at the top, negative supplies at the bottom and 
netlabels used to clarify connections and reduce congestion. 

Components may be grouped by function and boxes may be drawn around them. 

Decoupling components may be drawn adjacent to the devices they are associated with or 
symbols with dedicated sub-parts for power pins can be used to reduce congestion;

af://n353
af://n363


Use the Design Manager (left-click the Design Manager button in the left hand panel) to 
check that all components are present in the schematic and that all nets have been assigned 
reasonable mnemonic names and have at least two connection. 

Naming nets instead of relying on the EasyEDA auto-generated alphanumeric names makes 
signal tracing and debugging the final PCB much easier but care must be taken to ensure that 
names are correct and that there are no unintended duplicate names or accidental increments in 
numbered nets;

Verify that there are no duplicate prefixes in the schematic:

https://easyeda.com/forum/topic/How_to_resolve_quotPrefix_Conflictquot_error_-gpbca8642

Remember to check across all sheets of a multi-sheet schematic;

Check that the schematic is drawn correctly. 
In particular, check that no nets have been accidentally cross connected, that wires have join 
dots where they are intended to be joined, that they are properly connected to component 
pins and that nets joined by netlabels are correctly named and that there are no unintended 
duplicate net names.

Verify that junctions of 4 or more wires are drawn to show staggered junctions to avoid 
confusion with wires that cross but are not joined at the crossing point.

https://easyeda.com/forum/topic/How_to_resolve_quotPrefix_Conflictquot_error_-gpbca8642


Check that all parts and nets have been placed with the Canvas Attribute Snap = Yes:

and that no parts have been placed off grid so that although they may appear to be 
connected on close inspection it can be seen that they are not:

Check that pins have been terminated (pulled up, down, left open etc.) as specified in 
manufacturers'  datasheets. 
Check that all unconnected pins have No Connect symbols attached directly to them. 
Unconnected pins without No Connect symbols attached directly to them will show up as 
alphanumeric net names in the Design Manager but will not highlight when clicked on in the 
Design Manager.
No Connect symbols must be attached directly to component pins. There should be no wire 
between the No Connect symbol and the pin.



Note that the No Connect symbol changed in V4.8.5 of EasyEDA from a red cross to a green 
one to make the highlighted state of a selected symbol clear;
Check that the device ratings are suitable for the circuit in which they are to be used. For 
example, capacitor, diode, transistor, connector and switch voltage ratings, transistor, 
resistor and zener diode power dissipations, inductor, diode (including LED), transistor, 
connector and switch current ratings.  

Although these parameters should have been checked at the time of specifying the components 
as an essential part of the circuit design stage prior to or during Schematic Capture, there is 
plenty of scope for them to have gone astray during the part selection, placement and editing 
steps of Schematic Capture.  

An undetected mistake now can result in the wrong size part being chosen. For example a larger 
diameter or even a taller electrolytic capacitor may be needed. Whilst this is easy to correct in the 
PCB design stage, at best this may waste time in having to redesign part of the PCB. At worst the 
mistake may not be discovered before the PCB design is completed and sent for manufacturing.

Check that diode (including LED) and bipolar transistor base-emitter junction reverse 
breakdown voltage ratings and that input differential and common mode voltage ratings of 
operational amplifiers and comparators are not exceeded during any state of operation of 
the circuit including power up and power down. 

Consider adding diode or MOSFET reverse supply protection especially for battery powered 
circuits.

An example of MOSFET reverse protection is described in:

https://easyeda.com/example/Uberclamp_Schematic_PCB_and_BoM-r4YgysK2k

Pay special attention to this in operational amplifier or comparator devices that exhibit output 
phase reversal  under some input conditions. For more information about this see:

http://www.analog.com/media/en/training-seminars/tutorials/MT-036.pdf

For example, the TL081 exhibits this behaviour but it is not documented in more recent versions 
of the datasheet. See Applications Hints on page 5 of this earlier version:

http://www.physics.ucc.ie/fpetersweb/FrankWeb/courses/PY2108/spec%20sheets/TL081%20OpA
mp.pdf

Consider adding diode or MOSFET reverse supply protection especially for battery powered 
circuits.

An example of MOSFET reverse protection is described in:

https://easyeda.com/example/Uberclamp_Schematic_PCB_and_BoM-r4YgysK2k

https://easyeda.com/example/Uberclamp_Schematic_PCB_and_BoM-r4YgysK2k
http://www.analog.com/media/en/training-seminars/tutorials/MT-036.pdf
http://www.physics.ucc.ie/fpetersweb/FrankWeb/courses/PY2108/spec%20sheets/TL081%20OpAmp.pdf
https://easyeda.com/example/Uberclamp_Schematic_PCB_and_BoM-r4YgysK2k


Check that LED currents are supplied through series current limiting resistors or from 
constant current sources.

For background on this please see:

https://easyeda.com/andyfierman/LEDs_must_have_series_resistors-OoGYgCK2k

Check that signal connectors have sufficient ground pins to maintain signal integrity by 
minimising signal return path impedances (i.e. ground loop area). This is especially 
important in designs with high speed signals through the connectors but can also be 
important for lower speed signalling with long wire interconnects and/or fast edge speeds.
Check that power connectors have sufficient ground and power pins pins to maintain power 
integrity by minimising power and ground return path impedances. 
Verify that device power supply decoupling complies with manufacturers’ 
recommendations. 

Where possible, check datasheets, applications notes and schematics and PCBs for Reference 
Designs or Evaluation Boards.

For some background on the importance of adequate decoupling please see:

https://easyeda.com/andyfierman/Power_supply_decoupling_and_why_it_matters_-451e18a0d36
b4f208394b2a2ff7642c9

Verify that a Schematic Symbol and an associated PCB footprint has been created for every 
Part needed to construct the complete PCB. 

Remember to include Schematic Symbols and an associated PCB footprints for things like heat 
sinks, PCB mounting holes, mounting holes for PCB mounted potentiometers and switches (for 
example where a PCB is used as a front panel or as a self-contained test jig), test points, wire 
links or jumpers, fuse holders and even image based elements such as high voltage warnings and 
logos; 

Look in: 

Libraries (or SHIFT+F) > SCH/Footprint > Personal > Favorite
![](https://image.easyeda.com/images/easyeda-311_FAQ_LibrariesSCHlibPersonalFavorite.png]

and verify that every Schematic Symbol and associated PCB footprint chosen from the User 
Contributed category has been added to your local library;  

Verify that the pin numbers/names of the Schematic Symbol(s) for every Part are correct, 
unique and match those of the PCB footprint's pad numbers associated with that particular 
part;
Verify that the pin order (pin mapping) of the PCB footprint associated with every part is 
correct.

This task is simplified using the EasyEDA Footprint Manager:

https://docs.easyeda.com/en/Schematic/Footprint-Manager/index.html

https://easyeda.com/andyfierman/LEDs_must_have_series_resistors-OoGYgCK2k
https://easyeda.com/andyfierman/Power_supply_decoupling_and_why_it_matters_-451e18a0d36b4f208394b2a2ff7642c9
https://image.easyeda.com/images/easyeda-311_FAQ_LibrariesSCHlibPersonalFavorite.png
https://docs.easyeda.com/en/Schematic/Footprint-Manager/index.html


Remember that in EasyEDA, the PCB Footprint is viewed looking down onto the component side 
of the board. This view is assumed to be with all components mounted on the Top Layer. 
footprints can subsequently be placed on the top or bottom layers as required.

Verify that all necessary information about the specific components (and any suitable 
alternatives) that are to be used in the circuit and which are ultimately intended to be 
mounted on or form an integral part of the PCB, from which a Bill of Materials (BoM) can be 
generated has been added to the Schematic Symbols.

For more information about this please see:

https://easyeda.com/forum/topic/How_to_add_extra_information_to_the_Bill_of_Materials_BOM-
Hp9rJCUcu

Verify that any necessary information relating to the physical placement of components and 
layout of copper traces and areas has been annotated in the schematic.

Including text (or even diagrammatic information in the schematic about component positioning 
and orientation, clearances around heatsinks for airflow or copper areas for heat sinking, current 
and voltage ratings of traces, trace length matching, controlled impedance transmission lines and 
differential pairing can all help in the following stages of PCB design.

Nets that are carrying high currents may be drawn using thicker wires (Stroke width).

Nets can be drawn converging at star points to help illustrate where this type of PCB layout is 
required on the PCB:

https://easyeda.com/forum/topic/How_to_add_extra_information_to_the_Bill_of_Materials_BOM-Hp9rJCUcu


Kelvin connections to current sense resistors can be drawn in a similar way:

Nets can be colour coded but beware using red because it can be very hard to see when such 
nets are highlighted.

Generate - and check - the Bill of Materials (BoM) information and check the availability of 
components.

Whilst it is easy to change parts in the PCB design stage, at best this may waste time in having to 
redesign part of the PCB. At worst the unavailability of a part may not be discovered before the 
PCB design is completed and sent for manufacturing.

Use the Design Manager (left-click the Design Manager button in the left hand panel) to 
check everything again!

 

How to Update  

 

Version Rule

af://n465


EasyEDA version number is 
ReleaseCountsOfThisYear.MajorVersion.ReleaseCountsOfThisMajorVersion . For example, 
v4.9.3 is the fourth year released of EasyEDA, and  nine major versions are released in this year, 
EasyEDA had released 3 times in this major version.

Version Upgrade

If you use EasyEDA online, it can seamlessly upgrade by itself. However,EasyEDA uses an App 
Cache technique to allow you to use EasyEDA offline (W3C HTML5 Offline Web Applications) 
which may delay the automatic upgrading process. Therefore, if you want to upgrade to the 
latest version immediately, you can follow the two simple steps below.

1. Check the About... dialog; 
2. If the Built Date is older than 2017/06/01:

Close your browser open EasyEDA again.
If the Built Date is still showing older than 2017/06/01:
Close your browser and open EasyEDA again.
If the Built Date is at or newer than 2017/06/01, you don't need to do anything.

Note: 2017/06/01 is just an example.  

If those two steps don't work, you may need to clear your browser's cache:

1.Mozilla Firefox  

Close the editor, Go to “Preferences… > Privacy & Security > History > clear your recent 
history” or use Ctrl+shift+Delete,
Click on “Clear now”,
Reload easyeda again.

  

2.Chrome  

Close the editor, Open the following URL: chrome://appcache-internals/ .

Look for easyeda.com and click “Remove”.  

http://dev.w3.org/html5/offline-webapps/


Reload easyeda again.

 

 

Or you can use hotkey Ctrl+shift+Delete to delete Chrome caches.

 

 

3.Desktop Client

Close client and re-open it.



If doesn't work, rght-clik start page, use "Inspect Electment".

Switch to "Application" - "Clear storage", enable "Cache storage" and "Application cache", 
then click "Clear site data".

Restart Client.

User Center FAQ  

How to change password  

Via: User Center > Account > Password Setting

How to recover the deleted file  

Via: User Center > Recycle Bin

Find the file you want and then recover it.

af://n511
af://n514
af://n516
af://n519


How to transfer project or library to the team  

Transfer project: Enter the project, via: Setting > Advance Setting > Transfer Project

Transfer library: Move the mouse to the library, and then click the transfer icon.

How to delete project  

Via Project > Manage > Setting > Advanced > Delete Project

Contact Us  

Contact  

PCB Order Problems:  

support@jlcpcb.com    

At present, EasyEDA PCB service is transfer to JLCPCB.com , we are the same company 
group, any PCB orders problem please contact with JLCPCB .   

 

Parts Order Problems:  

support@lcsc.com    

EasyEDA provides direct links to LCSC thousands of components. Please order at LCSC.COM, 
any parts order problem please contact with LCSC .   

All Other Inquiries About EasyEDA:  

About editor usage and skill, Please refer the tutorial first. EasyEDA tutorial
EasyEDA forum
support@easyeda.com  . If you met some problems with design, please attach your design 
by EasyEDA source file and how to repeat the issue.

Notice  

EasyEDA team may not have the time or resources to help you fix all your problems; we may just be 
able to help you to fix problems commonly encountered by newbies, such as using a drawing polyline 
in place of a wire, finding a spice model for a simulation or selecting the right PCB footprint.

Please note that although some browsers or plug-ins allow you to use gestures, EasyEDA does not 
work with gestures, so you should disable this function.
Simulation editing is not yet fully supported: care must be taken because the last save by any 
collaborator overwrites all previous saves.
It can also find the value text but it cannot step through multiple components with the same 
value.

af://n519
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af://n531
https://jlcpcb.com/
https://jlcpcb.com/
af://n541
https://lcsc.com/
https://lcsc.com/
https://lcsc.com/
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Take a few moments to think about your username because this is the name that other users will 
see on your designs and posts if you choose to share them or make them public. Once you have 
created an account, you cannot change your username.
You can use upper and lower case letters, numbers and symbols to make a strong password but 
don't forget that the password entry is case sensitive.
Except ordering of PCBs directly from EasyEDA.
If you always open EasyEDA in the same browser on the same machine, your Anonymous files will 
appear under the Anonymous Files folder in the left hand panel but you should not rely on this as 
a way of keeping track of Anonymous files.

 

Business Development/Cooperation About
EasyEDA:

 

   

Address:  

F5, Tianjian Building, No.7 Shangbao Road, Futian District, Shenzhen, Guangdong, 518000, 
China   

                                        

 

 

 

Introduction to EasyEDA  

Welcome to EasyEDA, a great web based on EDA(Electronics Design Automation) tool for 
electronics engineers, educators, students, makers and enthusiasts. 

There's no need to install any software. Just open EasyEDA in any HTML5 capable, standards 
compliant web browser.

Whether you are using Linux, Mac or Windows,Highly recommend to use Chrome or Firefox as 
your browser ,you can also download EasyEDA client.
EasyEDA has all the features you expect and need to rapidly and easily take your design from 
conception through to production.

EasyEDA Editor: https://easyeda.com/editor  

Instruction:   

This tutorial document will be updated according to the updated EasyEDA editor.

EasyEDA Provides:   

Simple, Easier, Friendly, and Powerful general drawing capabilities

af://n578
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Working Anywhere, Anytime, Any Devices

Real-time Team Cooperation

Sharing Online

Thousands of open source projects

Integrated PCB fabrication and Components purchase chain

API provide

Script support

Schematic Capture

LTSpice-based Simulation
Spice models and subcircuits create
WaveForm viewer and data export(CSV)
Netlist export(Spice, Protel/Altium Designer, Pads, FreePCB)
Document export(PDF, PNG, SVG)
EasyEDA source file export(json)
Altium Designer format export
BOM export
Mutil-sheet schematics
Schematic module
Theme setting
Document recovery

PCB Layout

Design Rules Checking(DRC)
Mutil-Layer, 6 copper layer supported
Document export(PDF, PNG, SVG)
EasyEDA source file export(json)
Altium Designer format export
BOM export
DXF export
Photo view
3D View
Generate the fabrication file(Gerber)
Export Pick and Place file
Auto Router
PCB module
Document recovery

Import

Altium/ProtelDXP ASCII Schematic/PCB
Eagle Schematic/PCB/Libraries
KiCAD Schematic/PCB/Libraries
DXF

Libraries

More than 700,000 public Libraries(Symbol and Footprint)
Libraries management
Symbol/Subpart create and edit
Spice symbol/model create and edit
Libraries management
Footprint create and edit

 

https://jlcpcb.com/
https://lcsc.com/
https://www.analog.com/en/design-center/design-tools-and-calculators/ltspice-simulator.html


 

 

Design Flow by Using EasyEDA  

You can create circuits design easily by using EasyEDA. The design flow as below:

af://n712


UI Introduction  

EasyEDA Editor has a clearly and friendly user interface. You can use its every function very easily 
when you become familiar with EasyEDA.

Filter  

Before using the Filter, you need to select what module you need in the left navigation panel, and 
then you can find projects,files, parts and footprints quickly and easily just by typing a few letters 
of the title. For example, if you want to find all files containing “NE555” in the title, just type “555”, 
it is non-case-sensitive.

  

The Filter could only find projects, files and part titles and names. It does not support the 
Descriptions and Content fields.

Click the X to clear the filter.

af://n718
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Navigation Panel  

The Navigation panel is very important for EasyEDA: The part that you can find all your projects, 
files, parts and footprints.
  

Project
Here, You can find all of your projects that are private or shared with the public, or fork from 
someone else's. 

Except System IC, these options have a content menu. For example, if you drop down to My 
Projects and right click an item, you will get a tree menu like :

EELib
EElib means EasyEDA Libraries, It provides lots of components completed with simulation 
models, many of which have been developed for EasyEDA to make your simulation 
experience easier.  
Design Manager
Design Manager, you can check each component and net easily, and it will provide 
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DRC(Design rule check) to help your design better.

Libraries 
Contains schematic symbols and PCB footprints for many available components and 



projects and your own libs and modules will show up here.

LCSC
If you want to buy components to finish your PCBA, you should try the LCSC module, 
LCSC.com and EasyEDA are the same company.
EasyEDA partners with China's largest electronic components online store by customers and 
ordering quantity launch https://lcsc.com.
 LCSC means Love Components? Save Cost! We suggest to our users to use LCSC parts to 
design. Why?   

1. Small Quantity & Global Shipping.  
2. More Than 25,000 Kinds of Components.  
3. All components are genuine.   
4. It is easy to order co after design.   
5. You can save 40% cost at least.  
6. You can use our components' symbols and footprint directly in EasyEDA editor.  

JLCPCB
JLCPCB.com, LCSC.com and EasyEDA are the same company group.  https://jlcpcb.com
More than 200,000 customers worldwide trust JLC, 8000 + online orders per day,JLCPCB 
(Shenzhen JIALICHUANG Electronic Technology Development Co.,Ltd.), is the largest PCB 
prototype enterprise in China and a high-tech manufacturer specializing in quick PCB 
prototype and small-batch production.Affordable, series quality boards fully manufactured 
in China. Fully e-tested. Transparent pricing.

ToolBar  

EasyEDA think that, by using the icon is better than the text menu for the toolbar.

EasyEDA's toolbar can be reconfigured via Common Buttons Setting…

https://lcsc.com/
https://jlcpcb.com/
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Click on a button to select it. Then you can toggle button visibility by clicking on Show/Hide or by 
clicking on the tick space to the left of the button icon. You can change the button position 
using Move up and Move Down.

Many of the buttons have been assigned hotkeys, so you can use those to replace the button 
actions.

Preview Dialog  

The Preview dialog will help you choose components and footprints and can help you to identify 
schematics and PCB layouts.

You can close or open this dialog via:  

 ** View > Preview Window **.

The Preview Dialog has a resizing handle in the bottom right corner.
The Preview Dialog can't be closed but double clicking on the top banner will roll up the 
panel or you can click the top right corner —  . Double clicking top banner again toggles it 
back to the selected size.  

Clicking on the little pencil edit tool opens the item in the preview for editing. Clicking on the 
location place tool in the top right corner of the preview dialog places the item onto the 
canvas. If you try to place PCB footprint into a schematic it will not provide any action and 
message.

af://n765
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Wiring Tools  

Wiring Tools are document type sensitive: different document types have different tools.

Drawing Tools  

To keep EasyEDA's UI clean and sharp, the Wiring and Drawing tools palettes can be resized 
horizontally, rolled up or hidden so if you want to focus on drawing, you can roll up or hide the 
others to make more space and reduce the clutter.

Canvas Attributes  

You can find the canvas Properties setting by clicking on any of the blank space in the canvas. if 
you double-click the blank space the attribute dialog will pop up.

af://n776
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Background and grid colors and the style, size, visibility and snap attributes of the grid can all be 
configured.

The canvas area can be set directly by the Width and Height or from available preset frame sizes.

Canvas  

This is where it all happens! This the area where you create and edit your schematics, PCB 
layouts, symbols, footprints and other drawings, run simulations and display WaveForm traces.

  

 

How to Create a New Project or File  

After logging in, you can create a new project:

af://n788
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 Document > New > Create a new project/Schematic..etc

   

The Project concept is important in EasyEDA because it is the foundation of how to organize your 
designs.

Owner: You can change the owner of this project, you can change the owner to the team if 
you have joined.
Title: Give it a title: this will show in the project tree in the left hand panel.
Path: EasyEDA allows you set the path for the project, if you want to share with your friend, 
it will be useful. It can't be editable when it is created.
Visibility: You can make your project public or private by setting its Visibility.
If you choose to make you project Public, Categories allows you to select which category you 
want your project to be listed under on our website. If you keep your project private then 
the category is still applied but has no direct use in sorting your projects because this field is 
not searched in the Filter box in the left hand panel.
Description: Adding a short description helps you and anyone you are sharing this project 
with understand what the project is about.



Once created, to modify your project, right click on it in the project tree in the left hand panel,

then will open a web page in which you can edit your project:

From here, you can change the Visibility, allow other people to comment on your project and 
type a more detailed description of the project content. To help you make your project stand out 
or to maybe simply make a detailed description of your project easier to read, you can use 
Markdown syntax. If you need more information on Markdown syntax, click on Markdown 
Syntax? just above the Content box.
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Schematic Capture  

EasyEDA can create highly professional looking schematics.

Because EasyEDA has some simple but powerful drawing capabilities, you can create your own 
symbols either by copying existing symbols into your own library and then editing and saving 
them, or by drawing them from scratch.

There is also a Schematic Symbol Wizard to quickly draw new symbols for DIP , QFP  and SIP

A feature of EasyEDA is that as well as extensive libraries of the usual simple “2D” graphical 
schematic symbols, it has a library of drawn 3D  component symbols, i.e. symbols that look like 
the physical components that they represent.

If you have enough time and patience using the drawing features to full effect in symbol 
creation, your schematic can be built like this:

af://n816


Another powerful feature is that it is also possible to import symbols from Kicad , Eagle  and 
Altium  libraries.

PCB Layout  

When you are satisfied with your schematic design and simulation results, you can then quickly 
proceed to produce your finished and populated PCB without leaving EasyEDA.

EasyEDA's PCB Design canvas helps you to quickly and easily lay out even complex multilayer 
designs from schematics you have already created in the Schematic canvas or directly as a layout 
with no schematic.

Passing an EasyEDA Schematic into the PCB Design editor is as easy as clicking a button: Just 
click the Convert to PCB PCB icon on the top toolbar!

EasyEDA has extensive libraries of footprints. You can also build up your own library of 
unusual and specialized parts by copying and modifying existing parts or from scratch using 

af://n828


EasyEDA's powerful footprint creation and editing tools.

In a similar way as in the Schematic design canvas, to help you locate items and navigate 
your way around when working in the PCB Design canvas there is a PCB Design Manager.
Left Navigation Panel > Design Manager
The PCB Design Manager is a very powerful tool for finding components, tracks (nets) and 
pads (Net Pads).
Clicking on any item highlights the component and pans it to the center of the window.  
You can set up layers used in the PCB and their display colours and visibility using
Setting > Layer Options...
The active layer and layer visibility can be selected using the Layers Toolbar.
Default track widths, clearances and via hole dimensions can all be configured in the Design 
Rule Check dialog which is opened via:
Setting > Design Rule Setting...
From first setting up the Design Rule Check (DRC) at the start of your board layout, running 
a DRC is almost the last step in checking your PCB design before you generate Gerber and 
Drill files for board manufacture ready to place your order for a finished PCB.
The last step is to check the Gerber and Drill files using an easy way it is to install and use 
Free and Open Source Software Gerber Viewer: Gerbv: http://gerbv.geda-project.org/ 
While you are waiting for your PCB to be delivered, you can create a Bill of Materials (BOM) 
via:
Document > Export BOM...
And you can produce professional quality SVG , .png  or .pdf  output files for your 
documentation.
PCB Designs can be shared with colleagues and made public in the same way as Schematics.
The size of PCB that you can produce using EasyEDA is almost unlimited: designs of over 
100cm * 100cm are possible … but you might need a powerful computer for that.
EasyEDA supports up to 6 layer PCBs by default but it is capable of handling more, so if you 
need more layers then please contact us.  

Search footprints  

Searching footprints is the same as searching symbols by using Libraries in the Schematic.
You can place the selected footprints in the canvas after the search.

 

http://gerbv.geda-project.org/
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Libraries Management  

Thanks to the Free and Open Source Kicad Libs and some Open Source Eagle libs, EasyEDA now 
has 700,000+ components, which should be enough for most projects.

Now you can enjoy using EasyEDA without having to spend so much time hunting for or building 
schematic symbols and PCB footprints.  

Library
On the left hand Navigation panel you will find "EElib" and "Library", just type what 
components you want and search.
At Libraries:

Steps: 

1.Choose the library type
2.Typing the keyword such as "1k 0603"
3.Click the search button
4.Select the class you which is wanted of the result
5.If you don't need the search you need to remove all the search keywords

Create Libraries
EasyEDA supports creating symbols by yourself, after created you can find out your 
components at Libraries > Symbols/Footprints > Personal, and it is easy to manage your 
libraries.

af://n854


Transfer Libraries
If you want to transfer your libraries to the team, you can do that in "User Center > Libraries 
> Personal".

To prepare for the final assembly stage you can create a Bill of Materials (BOM) via:

Document > Export BOM...

and you can produce professional quality SVG , .PNG  or .PDF  output files for your documents.

All EasyEDA Schematic Symbol and PCB Footprint libs are public, so after you have created and 
saved a new symbol or footprint, others will be able to find your part and you will be credited as 
a contributor.   https://easyeda.com/page/contribute

 

https://easyeda.com/page/contribute
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Version-Control  

EasyEDA provide a simple but powerful version control feature. Each version is independent, you 
can edit and save for every version.
When create the new project, it will be set the default version name as "master", you can edit the 
name at the "Project Manage - Version" page.

You can create 10 versions for every project. The more versions you need to delete the older 
first.

Create New Verison  

Via: Project folder - right-click menu - Version - New Version

At the new version dialog, you need to type the version's name and description, and create it.

If you want to switch to new version, you have via "Version - Switch Version".

Switch Version  

Click "Switch", the dialog will list current version and all version for this project, you can select 
one and switch to it.
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Notice:  

Before switching the other version, you have to close the current version's document 
manually first.
You only can open the current version's document, if you want to open other's version's 
document, you have to swicth the version first.
If you not sure which verison it is, you can check it at "Switch Version" dialog, or hover the 
mouse cursor on the project folder.

Version Management  

Via "Version Management", will open the "Project Page - Version".
Version page will list all versions, you can edit the versions' name and description, or delete 
them. Current version can't be deleted.
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Share to Public  

Sharing your work with others is a big feature of web based EDA tools and EasyEDA is no 
exception in offering you some nice features.

Did you create a really cool project with EasyEDA? Show it off and be super helpful to other 
EasyEDA users, you just need to set your projects to public, so others can explore your circuits.

All projects in EasyEDA are set to private by default, your private project can not be shared with 
anyone.
i.e. to make it public, you should create a new project or right click and edit your existing project 
to be a Public project:  

1.Create New Project：
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2.Edit Existing Project:    

At the User Center, click Share icon when the mouse hover the project cover, it will ask you 
to confirm.

Or enter project manage page, via "User Center > Project > Manage > Settings > Basci > 
Project proerty:Public"

  

At the editor, you can right-click the project, click the Share  menu, after setting the project 
as public, you will see that the Project folder Icon is now shown as a hand holding the folder.



If you already open the documents of the project you want to share, you can then click the 
Share icon on the topbar, that will open the Share my works dialog.

Or you can click the Share menu or Share icon at the topbar.

Project Member  

How to share project with selected people?

Can you share a private project with your partner? Can your partner modify your designs?

Yes, you can use Member to do this.

Right click the project and you will see the Member on the context menu; clicking on it will open 
the Member webpage.  
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So if you want to share a project with someone,

1. You just need to know their E-mail address which they have used to create an account with 
EasyEDA

2. The project member you can set as "Developer","Manager",and "Observer".

After setting up Member and Permissions, your partner will find your project in 
the Project section from the left Navigation Panel when they login.

If you partner doesn't wish to accept the shared project, they can reject it by leaving the project 
when they enter this project "Add Member" function.

User Preference  

When EasyEDA shows up the login success pop up in the bottom right of the window, your user 
management menu will be look like this:

Click on User Preferences,  

Document Recovery Setting:

Maximum backup level: Every opened document can be saved as a backup to this number 
of different revisions.
Auto backup(minutes): This is the time interval between auto saves of all your opened 
documents.
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The Document Recovery function you can find at:

Save to Server: Save your preferences (Hotkey settings, language and so on) to the 
EasyEDA Server.

Load from Server: EasyEDA can't load your Preferences automatically but once you have saved 
them, you can load them manually. Then, when you change to a different computer or browser, 
you can load your preferences from the EasyEDA Server.

If you have not saved any preferences then Load from Server will have no effect.

Shortcut Keys  

After a while of using an EDA tool suite, clicking all over the place with a mouse gets very tedious 
and seriously reduces your productivity. Keyboard shortcuts or Hotkeys avoid much of 
that. EasyEDA not only provides lots of hotkeys, but also every hotkey can be reconfigured.

Under the Config toolbar, click the Hotkeys Setting... Menu which will open the Hotkey 
Setting dialog.
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To change a Hotkey, click anywhere in the row for the hotkey you want to change and then press 
your new key.

For example, if you want to use R instead of space to rotate selected objects, click on the first 
row, then press  R .

After you change the hotkey, don't forget to click Save Changes button.

The docType column describes which type of EasyEDA document each hotkey applies to. 
docType has three types:

ALL: any document type in EasyEDA.
SCH: schematic and schematic libs
PCB: PCB and Footprints.

The functions of some hotkeys may change between docTypes. For example, the hotkey  C  draws 
an Arc in SCH, but draws a circle in PCB.

A list of all the available default hotkeys is given below. 

All document  
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DocType Shortcut Function

All Space Rotate selected objects

All Right-Click
Keep right-click to pan canvas; Open offset dialog when

select one object

All Left Scroll Or Move selected left

All Right Scroll or Move selected right

All Up Scroll or Move selected up

All Down Scroll or Move selected down

All TAB
Change object's attributes when placing; Open offset dialog

when select a object

All Esc Cancel current drawing

All Home setting new canvas origin

All Delete Delete Selected

All F1 Open tutorials

All F11 Full screen at browser

All A Zoom In

All Z Zoom Out

All D Drag

All K Fit Window

All R Rotate selected objects

All X Flip Horizontal(doesn't support footprint)

All Y Flip Vertical(doesn't support footprint)

All ALT+F5 Full screen at browser

All Ctrl+X Cut

All Ctrl+C Copy

All Ctrl+V Paste

All Ctrl+A Select All

All Ctrl+Z Undo

All Ctrl+Y Redo

All Ctrl+S Save

All Ctrl+F Find Component

All Ctrl+D Design Manager



DocType Shortcut Function

All Ctrl+Home Open canvas origin setting dialog

All Shift+1 Cycle forward to next open tabbed document

All Shift+2 Cycle backward to next open tabbed document

All Shift+X Cross Probe

All Shift+F Search Libraries

All Shift+Drag Cursor snap to part's origin

All SHIFT+ALT+H Align horizontal centers

All SHIFT+ALT+E Align verticas centers

All CRTL+SHIFT+L Align left

All CRTL+SHIFT+R Align right

All CRTL+SHIFT+O Align top

All CRTL+SHIFT+B Align bottom

All CRTL+SHIFT+G Align grid

All CRTL+SHIFT+H Distribute Horizontally

All CRTL+SHIFT+E Distribute Vertically

All CTRL+SHIFT+F Find similar objects

 

Schematic  
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DocType Shortcut Function

Schematic W Draw Wire

Schematic B Draw Bus

Schematic U Bus Entry

Schematic N NetLabel

Schematic P Place Pin

Schematic L Draw Polyline

Schematic O Draw Polygon

Schematic Q Draw Bezier

Schematic C Draw Arc

Schematic S Draw Rect

Schematic E Draw Ellipse

Schematic F Freehand Draw

Schematic T Place Text

Schematic I Edit Selected Symbol

Schematic Ctrl+Q NetFlag VCC

Schematic Ctrl+G NetFlag GND

Schematic Ctrl+R Run the Document

Schematic Ctrl+Shift+X Cross Probe and Place

PCB  
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DocType Shortcut Function

PCB W Draw Track

PCB U Draw Arc

PCB C Draw Circle

PCB N Draw Dimension

PCB S Draw Text

PCB O Draw Connect

PCB E Draw copperArea

PCB T Change To TopLayer; Change selected part to toplayer

PCB B
Change To BottomLayer; Change selected part to

bottomlayer

PCB 1 Change To Inner1

PCB 2 Change To Inner2

PCB 3 Change To Inner3

PCB 4 Change To Inner4

PCB P Place Pad

PCB Q Change canvas unit

PCB V Place Via

PCB M Measure

PCB H
Highlight Net all the time, press it again cancel

highlight

PCB L Change Route Angle

PCB -
Decrease Routing Width; Switch to the forward signal

layer

PCB + Increase Routing Width; Switch to the next signal layer

PCB * Cycle switch to the next signal layer

PCB Delete Delete selected object; Undo the track when routing

PCB Alt-- Decrease Snap Size

PCB Alt++ Increase Snap Size

PCB CTRL+R Depend on reference point for copy object repeatly

PCB CTRL+L Open layer manager

PCB CTRL+Q Hide/show network text



DocType Shortcut Function

PCB Shift+M Remove All Copper Area fill data

PCB Shift+B Rebuild All Copper Area

PCB Shift+D Move Object(s) by reference point

PCB SHIFT+G Display track length while routing

PCB SHIFT+W Show favorite track width while routing

PCB SHIFT+R Change routing conflict

PCB SHIFT+S Toggle layers which is not active

PCB SHIFT+Double Click Delete selected track segment

PCB CTRL+SHIFT+C Copy object(s) by reference point

PCB CTRL+SHIFT+V
Paste object(s) and keep the prefix, and hide the

ratline layer

PCB CTRL+SHIFT+SPACE Change routing angle, same as hotkey L

 

 

Basic Skills  

To use EasyEDA, you need to be familiar with a few basic terms and concepts. The best way to 
learn them is to open up EasyEDA, open a new schematic:

Document > New > Schematic , and play!

Saving Your Work Locally  

Although EasyEDA saves all your files on our Server, sometimes you may want to save your work 
locally and EasyEDA provides a hack way to do this.
You can right-click your project folder, and click "Download Project", or export your design as 
EasyEDA source file via "Document > EasyEDA Source".
More detail you can view at Export EasyEDA Source section.

Or you can download your project.
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Histories Record  

It is easy to use this function, right click on the document for which you need the history in like in 
the image below:
After clicking on the history link, you will get a list of all of the Histories like in the image below.  

Click the History number, you can open the saved file in the editor, if this is what you need, you 
can save it to your project and delete your bad file.

Note:
1. For now all of the Histories are marked as number, we will allow you to add a tag soon.
2. Don't save your files too frequently, or you will get lots of Histories and it will be hard to find the 
exact one you want.

Document Recovery  

No operating system, software or network is perfect, so sometimes things can go wrong. Having 
your Desktop or web browser freeze or your broadband connection drop, two hours into laying 
out a PCB, could spoil your day.

However, with EasyEDA, your day will be just fine.
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This is because EasyEDA auto saves and makes backups of all your open files to your computer 
so crash recovery is built into EasyEDA.

On the topbar, click Document Recovery button on the top Toolbar as below:

Select the file which you would like to recover, then click the Recover button; your file will be 
opened in a new tab. 

Please note:  

EasyEDA saves these crash recovery files on your computer and not on the EasyEDA server. 
Therefore you cannot recover files from a crash on one computer or browser by changing to a 
different computer or browser.  
And if you cleaned your browser's cache, the recovery files will disappear.
If you make a mistake to delete a file and remove the cache already, maybe you can find your 
document back via recycle bin: https://easyeda.com/account/user/recycles/personal.

 

Resizing the canvas area  

https://easyeda.com/account/user/recycles/personal
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Hovering the mouse cursor over the areas indicated by the three green ellipses will bring up blue 
toolbar toggle lines. Clicking on them will toggle the visibility of their associated top, right and left 
toolbar areas to expand the canvas area. The vertical lines can also be dragged horizontally to 
resize the panels.  

Cursor Style  

 Some users don't like the cross cursor, so you can change it to arrow cursor like in the image 
below.
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These difference between these options is as below: 

Clear  

If you think your schematic or PCB looks terrible, and you want to redraw all units, you can:

Super Menu > Edit > Clear.  
Delete this schematic and create a new one.  
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Use Global Delete on the top toolbar Tools

Left clicking  

Similar to other EDA software: 

Click on an item to select it;
If over a selected item, click and hold to drag a selected item;
If not over a selected item, clicking and holding while dragging creates a selection box;
the selection box, using click and drag to the right, selects everything inside the box;
the selection box, using click and drag to the left, selects everything inside and intersected 
by the box;
Double click on a text area to edit it;
The exact left click functionality depends on what item is being selected and in what Canvas 
the item exists (Schematic or PCB).

Right clicking  

EasyEDA does not support right click context menus in the Schematic or PCB Canvas. Instead, 
right clicking executes a context sensitive command:

When you are placing a symbol, after a right click, the active symbol will be removed;
When you are drawing a shape such as a polyline, after a right click, the polyline will be 
stopped at the place where you right click but the mouse will remain as a cross, so you can 
draw another shape;
To get out of the current active context sensitive command such as  placement or drawing 
mode and go back to select mode, just double right click.

Ctrl+Right clicking anywhere in the Schematic, waveForm or PCB Canvas drags the canvas 
around within the EasyEDA window.

ESC key  

Pressing the ESC  key ends the current drawing action but does not exit the current active 
context sensitive command mode (i.e. it does not return the cursor to select mode).

Select more shapes  

Ctrl+left clicking on items adds those items to your selection;
Clicking and holding creates a selection box;
Creating a selection box, using click and drag to the right, selects everything inside the box;
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Creating a selection box, using click and drag to the left, selects everything inside and 
intersected by the box;

Zoom in and Zoom out  

Using the middle mouse button:
Roll forward to zoom in; 
Roll back to zoom out;
Using hotkeys, the default hotkey A  for zoom in, Z  for zoom out.

Please note: 
Do not roll your mouse at the same time as pressing the CTRL key. Some browsers will zoom the whole 
site, not just the canvas in the EasyEDA window. If this happens, just press  Ctrl+0  to reset the browser 
zoom.  

Double clicks  

Double clicking any text area opens a resizable text box to allow you edit the text inline.

Press enter to create new line. Click outside the text box to close it.

Pan/Move Canvas  

Right click anywhere in the Schematic, WaveForm or PCB Canvas and Hold down right 
button to drags the canvas around within the EasyEDA window.
If your canvas is bigger than the EasyEDA window and is showing scroll bars, you can use 
either the scroll bars or the Arrow keys to scroll the canvas to pan.
When drawing a wire, a graphic line or shape that you wish to extend beyond the edge of 
the EasyEDA window holding down the left mouse button after starting the line will pan the 
canvas to keep the drawn item inside the window.

Tip:
If you use Chrome, and cursor is in the canvas while pressing CTRL or ALT key and rolling your mouse, 
the canvas will move vertically, and when pressing SHIFT and rolling your mouse, the canvas will move 
horizontally.

Rotate  

After selecting one or more items, you can rotate the selected items using:

Super Menu > Edit > Rotate or click top ToolBar Rotate and Flip > Rotate Left or Rotate Right

or by pressing the default rotate hotkey: Space .
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If in PCB, you can click the footprint and change it's rotation at the right panel.

Please note:
Rotating a multiple selection rotates each item about its own symbol origin. It does not rotate the items 
about the centroid of the group of items.

Flip  

To place a Q2 as shown in the schematic below you need to Flip the item.

You can Flip one or more selected items using:   

Rotate and Flip > Flip Horizontal or Flip Vertical  from the toolbar,  

or by pressing the default flip hotkeys:  X  to Flip Horizontal, Y  to Flip Vertical.

Align  

EasyEDA provides many align option features, you can align your components or footprints very 
easily, it include:  

Align Left
Align Right
Align Top
Align Bottom
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Align Horizontal Center
Align Vertical Center
Distribute Horizontally
Distribute Verticall
Distribute Left Edges Equidistantly
Distribute Top Edges Equidistantly
Align Grid
etc...

Bring to Front and Send to Back  

In the image below, both the rectangle and the ellipse are filled.
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If you draw the ellipse before drawing the rectangle, the rectangle will overlap and therefore hide 
the ellipse. To reveal the ellipse, select the rectangle and then use:

Align > Send to Back  from the toolbar.

To bring the rectangle to the front again, you could select it and use:

Align > Bring to Front

or select the ellipse and then use:

Align > Send to Back

Documents Tab Switch  

It's easy to fit your documents tab location.

 

Schematic Capture  
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During this tutorial we will create a simple Schematic design to guide you in using EasyEDA 
Schematic capture.  

You can find the canvas Properties setting by clicking on any the blank space in the canvas.

As described earlier, background and grid colours and the style, size, visibility and snap 
attributes of the grid can all be configured.

The canvas area can be set directly by the Width and Height or by using the available preset 
frame sizes.

Grid:

Visible Grid : Yes or No
Grid Color: Any valid colour
Grid Style: Line or Dot
Grid Size: To ensure proper alignment of all EasyEDA parts, it is advisable to set in 10, 20, 
100. the unit is pixel.
Grid (and background) colour can be set directly by entering the hexadecimal value of the 
colour you want or by clicking on a colour in the palette that opens when you click on the 
colour value box:



Snap:

Snap: Yes or No. Pressing this key toggles switching snap to grid on and off.
Snap Size: To ensure proper alignment of all EasyEDA parts, it is advisable to set in 10, 20, 
100 but any valid number can work, such as 1, 5, 10.

It is strongly recommended that you keep Snap = Yes all the time. Once items are placed off-grid 
it can be very difficult to reset them back onto the grid. Off-grid placement can result in wires 
looking as though they are joined when in fact they are not and so causing netlisting errors that 
can be hard to track down.

If you need to draw detailed parts of new symbols or footprints that need to go between grid 
points, try to reduce the grid spacing to draw these elements and then reset the grid back to your 
chosen default value as soon as you have completed that part of the drawing. Setting Snap=No 
should only really be used as a last resort.

ALT Sanp: Snap size when pressing the ALT  key.

 

Wiring Tools  

 

If you have hidden your tools , you can open them from here: 
Top toolbar View > Wiring Tools...

Note: All of the commands in Wiring Tools are electronics related. Don't use a wire when you just need 
to draw a line, shape or an arrow: use Drawing Tools instead.  
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Wire  

There are three ways to enter the wire mode in EasyEDA.

1. Click the Wire button from the Wiring Tools palette.
2. Press the W  hotkey.
3. Click on the end of a component pin (where the grey pin dot appears if you select the 

component): 

 

EasyEDA automatically enters Wire mode.

Here is a screenshot of the Astable Multivibrator LED project schematic after wiring:

af://n1630


Moving Components And Wires:

If you place a component, such as a resistor, on top of a wire then the wire breaks and 
reconnects to the ends of the component.

When moving selected components using the mouse, they will drag attached wires with them 
(“rubber band”) to some extent but please be aware that the rubber banding feature has some 
limitations. When moving selected components most wire will move vertically and horizontally. 
Using the arrow keys will not rubber band. Selected wires do not rubber band.

A selected wire can be moved directly by clicking on it using the mouse or by the arrow keys. If a 
wire is selected by clicking on it using the mouse then green grab handles will appear at the ends 
and vertices.

Auto adjust connection

If you put a resistor or capacitor on a wire, the wire will auto connect the pins as below:



When you want to wiring a series of resistors which are in a row, you can just wire through them,  
and then you will find they all be connected.

 

Bus  

When you design a professional schematic, perhaps it will use a lot of wires. If you wiring one by 
one, much time would be wasted, and then you need to use Bus .
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Bus Entry  

If you decide to wire with Bus  , the Bus Entry  must connect to Bus and other nets with wires. 
such as in the above image.
The "Bus" and "Bus Entry" just for the indication, because when you place Bus and Bus Entry, you 
have to place the netlabel on the Bus Entry dot point.

Net Label  

NetLabel can be used to give your wires names to help you find them and identify any 
misconnections. You can find the NetLabel from the Wiring Tools palette or by using the 
N  hotkey. When selecting the netlabel, you will find its attributes in the right hand 
Properties panel: 

You can change its name and colour. If you only want to change its name, it may be easier to just 
double click the netlabel.

Multi-NetLabels in One Wire

EasyEDA support mutil-netlabel in one wire now.

When you convert the schematic to the PCB, the editor will choose the first netlabel you placed 
as the net name for this wire, as below NETLABEL1.
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As above image, when you click anyone netlabel's name in the design manager, the wire will be 
highlighted. 

Notice：

If wire 1 has 3 netlabels A  B and C, and wire 2 has netlabel A, then wire 1 and wire 2 are the 
same net.
Netlabel/Netflag/Netport/volprobe only support English characters and letters, and Arabic 
numerals.
If a part prefix is P1, which has two pins, it will have two nets "P1_1" and "P1_2" by default, if you 
place a netlabel named P1_1 at other wire which is not connect with P1 pin1, the default "P1_1" 
will change to "P1_1(1)" for avoid the wrong connection with netlabel "P1_1".

Net Flag  

NetFlag is the same as NetLabel, you can find the NetFlag from the Wiring Tools palette or using 
the  Ctrl+G  hotkeys for GND or  Ctrl+Q  for VCC. You can also change its name, for example 
from VCC to VDD:

The screenshot below is after adding NetLabels   

indicated by the little egg marks 
-and a GND NetFlag   

This schematic is almost finished.
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Wiring Tools palette provides NetFlag: Digital GND, Analog GND, VCC and +5V for your 
convenience.

Net Port  

At EasyEDA, Net Port works like Net Label, it doesn't differentiate the input and output net port. 
When you don't want to route too many wires, how about trying  Net Port  :  

It will make your schematic look more clean, and you just need to set each Net Port a net name.
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No Connect Flag  

You can find the NO Connect Flag  via wiring tool,   

,   

In the below schematic, if you don't add a NO Connect Flag , there is an error flag in the nets 
collection of the design manager. 

After adding a NO Connect Flag , the error disappears.  
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Note: NO Connect Flag  only works on the symbol's pin directly.

Voltage Probe  

 

EasyEDA provides a simulation feature for the schematic. After the simulation is running, you will 
see the waveform where you placed the voltage probes in the circuit.
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For more detail about the simulation, please check the Simulation section.

Pin  

When you create a new symbol in schematic and schematic lib, you must use Pin  to create pins 
for the new symbol, otherwise your symbol can't be wired with wires.

For more information please refer to the Schematic Lib: Pin section.

Group/Ungroup  

On the Wiring Tools palette there is the Group/Ungroup Symbol… button.

Just like the Symbol Wizard, this tool is also for you to quickly create schematic library symbols.

Using the Symbol Wizard you can only create generic symbols but how can you quickly and 
easily create symbols like these?

http://./SpiceSimulation.htm
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Here's how.

EasyEDA allows you to do something that very few other EAD tools support.

Using the P  Hotkey, you are allowed to add a PIN directly onto the Schematic canvas. So you can 
add 8 Pins, draw a rectangle from the Drawing Tools palette and add 555 as text to form a 
symbol for the NE555 like the one shown below:

Now comes the clever bit.

Up to this point you have a collection of separate pins, a drawn rectangle and some text that are 
all separate items with no particular association with each other.

So now select all of the items and click the Group/Ungroup Symbol… button. A dialog will be 
opened:



After you click OK, all those separate elements will be grouped together to form your new symbol 
directly in the schematic.

Using the group function, you can create any symbol in the schematic, easily and quickly.

How cool is that?

So what does Ungroup do? Try selecting a symbol and then click the Group/ungroup command 
to see what happens!

Note: 

The pin numbers and names cannot be moved independently of the pin.
The symbol you created in the schematic will not be save in the personal libraries, if you 
want to use it repeatly, please create a schematicLib.

If it's still difficult to understand, don't worry, you can see the process in the dynamic image 
below:

 

 

Drawing Tools  

Sheet Setting  

It is now possible to add design notes to the frame and the frame selection, for example A4, 
which can assist in aligning and improve the look of printed schematics and PCB designs. 

Click the frame button like in the image below, Or via: Topbar > Setting > Sheet Setting
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As illustrated in the image below:

And you can edit the blue text when you've selected the text attributes or double clicked it.

The bottom right zone can be selected and dragged or the frame can be dragged and deleted.

When you've selected the bottom right zone, you can edit the sheet attributes:

Line  
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In the Schematic editor, you can draw a line with any direction. You can change its attribute as in 
the image below:

  

Bezier  

With this tool, you can draw a pretty cool pattern.

Arc  
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You can draw the arc of any shape.

 

Arrow Head  

You can add arrow head to marking text or important part.

 

Text  

Text attributes provide many parameters for setting:

Text: You can change text in inner box or double click the text. For every new text, the 
default text is Text .
-Color: Defines text color.
-Font-family: It provides 12 fonts for choosing.
-Font-Size: Defines Text size.
-Font-weight: Defines Text weight.
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-Font-Style: It contains (auto), normal, italic.
-Text type: types include comment and spice.

The editor will remember your last text parameters. 

 

Image  

When you select Image from the Drawing Tools palette, an image place holder will be inserted 
into the canvas:

Select the place holder, so you can see the image's attributes in the right hand Properties panel:
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Set the URL of your image. For example, setting the URL to:

http://upload.wikimedia.org/wikipedia/commons/thumb/c/c7/555_Pinout.svg/220px-
555_Pinout.svg.png

will make your image look like this:

Please note: at present, EasyEDA cannot host images, so you need to upload your images to an 
image sharing site such as http://www.imgur.com.

Drag  

If you want to move some kind of parts and wires, you can use drag.
Or you can select the parts and wires area firstly and move them.

Canvas Origin  

http://upload.wikimedia.org/wikipedia/commons/thumb/c/c7/555_Pinout.svg/220px-555_Pinout.svg.png
http://www.imgur.com/
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Canvas origin default is set at left top corner of the schematic sheet, but you can set it where you 
want via Canvas Origin.  

For another way to set canvas origin, you can try Topbar > Place > Canvas Origin.  

 

 

Libraries  

 

EELib  

That contains ready made symbols for a wide range of components and which can be simulated.
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Many of these components have optional US and EU style symbols, we split them, so you can 
select those you like. Click on the drop down list or right click to popup the context menu, it 
contains many footprints or parameters. EasyEDA will remember your choices for the next time.

Don't forget to use Filter to locate a component fastly. For example, you just need to type? res ?to 
find all of resistors:
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Library  

EasyEDA provide a lot of libraries, you can find them at "Left-hand Panel - Libraries", hotkey 
"SHIFT+F", at here you can search library from LCSC, system, user contributed.

Type

Symbol: Schematic symbols
Spice Symbol: Symbols for spice simlation
Footprint: PCB footprints, PCB pattern.
SCH Modules: Schematic modules, a part of the circuit design. It can not assign the PCB 
module, doesn't like the schematic Symbol can assign the footprint . when it be placed on 
the schematic, it will be separated.
PCB Modules: As like as Schematic modules.

Classes

Work Space: It include your personal parts and your teams' parts.
LCSC: EasyEDA online part store LCSC.com parts(Officail Parts). It will add new libraries 
everyday
LCSC Assembled: JLCPCB Assembled parts. All JLCPCB assembly parts will contain a SMT 
icon, that means this part can be JLCPCB assemble.
System: EasyEDA system parts, it comes from open source libraries, such as Kicad libraries, 
company public libraries, user contributions.
Follow: If you follow a user at EasyEDA(You can follow a user at him/her user page), you can 
view and use his/her libraries.
User Contributed: When you searching a part, maybe you can find it at this class. At 
EasyEDA, all libraries are public. the detail you can refer at: Contribute

We add an LCSC Assembly Components option of the Parts, It's easy to choose which component 
can be assembled by LCSC. Yes, We will provide the assembly service. the more information 
please refer at: How to order a SMT order
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Search Libraries
Simply type your part number or symbol's name to Search. before searching, you must choose 
the "Type" first.

and then click the "Table of contents" to open the categories list to choose your components. 

From there you can scroll up and down to browse parts from each category.

If you know the component's name
Suppose you want to find the MAX232 (which converts signals from an RS-232 ?serial port to 
signals suitable for use in TTL ?compatible digital logic circuits). Simply type Max232  into the 
Search box and press Enter:

If you don't know the component's name
For example, you want to find a resistor which value is 1kohm, footprint is 0603, at Libraries 
you can follow below steps:

Steps: 

1.Choose the library type
2.Typing the keyword such as 1k 0603
3.Click the search button
4.Select the class you which is wanted of the result

http://www.google.com/url?q=http%3A%2F%2Fen.wikipedia.org%2Fwiki%2FRS-232&sa=D&sntz=1&usg=AFQjCNFt_BArd4HZuR1QqCUxvKGW3ki3UA
http://www.google.com/url?q=http%3A%2F%2Fen.wikipedia.org%2Fwiki%2FTransistor-transistor_logic&sa=D&sntz=1&usg=AFQjCNFoI3eJYGc8PWqUdnfqHGREfTZccw


5.If you don't need the search you need to remove all the search keywords 

When you hover the mouse over the picture of the Schematic symbol or PCB footprint, you will 
find a toolbar with "Edit", "Place", "More" buttons.

Place:
For parts you use infrequently,?you don't need to Favorite them; just Place it into your canvas 
directly.  Or you can double click the library to place.

Note: 

EasyEDA supports multi-documents so please make sure that you are placing the part into the 
right (active) document. The active document is the one with the highlighted tab.  
You can't place a Schematic symbol into a PCB file, or a PCB Footprint into a schematic.

Edit:
If you want to create your own version of a symbol or footprint then you can open an existing 
part from the library to use as a template, edit it and then save it to your local Personal?library in 
Libraries of the Navigation Panel.

More:
We can't promise that every component in the library is free of errors so please check all symbols 
and footprints carefully before you commit to a PCB order.

If you do find a mistake in a component, please use the Report Error , so that we can fix it.

Components with sub parts (multi-device footprints).

When you find a component with sub-parts, you can't Place or Edit it, but you can Favorite and 
Clone it as your own part, which you can then edit.



Preview Image

Every library when you click, you can check its preview image, such as SchematicLib, footprint, 
production picture. Click the the image you can open it quickly.

Placing Components  

Find the component which you plan to place to your schematic at "Libraries", then move your 
mouse to the canvas and left click. If you want to add more, just left click again. To end the 
current sequence of placements, right click once or press ESC .

Don't try to Drag and Drop a component to the canvas:?EasyEDA team thinks that Click-Click to 
place components will be easier to use than a Click-Drag mode.

Multi-part Components  

The number of pins on some components can be quite large. That's why it's easier to divide such 
a component into several parts or functional blocks. As a simple example, there are six gates in 
the 74HC04 Hex Inverter component. To avoid clutter in the schematic, GND and VCC pins of 
such components are usually served by a separate part of the component. This is really 
convenient as it doesn't interfere the working process with logical parts. The NetLabel names of 
VCC and GND Pin are usually hidden.

When placing the 74HC04 on a schematic, it will look like the screenshot below.  

Note: The component Prefix will be in form of: U?.1, U?.2 etc.
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Schematic Symbol Wizard  

How many times have you hit a schematic capture roadblock because you couldn't find a 
component symbol?

Well, in EasyEDA that would be never because?the Schematic Symbol Wizard?provides a quick 
and easy?way to create?a general?schematic library symbol.?  

The Schematic Symbol Wizard...?command can be found in the top toolbar. 

Or Edit > Schematic Symbol Wizard in a new schematic lib document.

The professional function please refer at Schematic Symbol Wizard

 

Component Attributes  

Component Attributes  

After selecting a component, you can find the component's attributes in the right hand 
Properties panel.

af://n1880
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1.**Part Attributes:** You can change the Prefix and Name here，And make them visible or 
invisible.
If you want edit this component, you can click Edit Symbol.

2.**Custom Attributes:** You can change component's supplier, change footprint, and add new 
parameter.

**3. If the part's property "Convert to PCB" is set as "No", it will not appear at footprint manager.

Define BOM Parameters  

After selected a schematic symbol, you can add a parameter, and you can mark it as In BOM , 
when you export a BOM file, you can find this parameter in CSV file.  
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Pinmap Modify Symbol Information  

When you select a component, for opening the Modify symbol information dialog, you can do:

1. Edit > Edit Symbol...;  
2. Or press the I  hotkey;  
3. Or click the Edit Symbol on the Parts Attributes on the left panel.  
4. Or click the Symbol and right-click, choose the "Edit Symbol" menu.

Using this dialog you can edit the pin names and numbers, for example, to suit a different 
footprint or device variant. You can also enter a Spice Prefix and swap the spice Pin order to 
make your symbol usable in simulation. 

More detailed description of PCB and Spice Prefixes and pin numbers at next section.

Prefixes and Pin Numbers  

Device and subcircuit (or hierarchical block) symbols created for use in schematics that are 
intended to be run as spice simulations, in addition to having a PCB Prefix that is used for the 
reference designator in the schematic, also have a Spice Prefix. They also have two sets of pin 
numbers: PCB pins and Spice pins.

PCB Prefix and Spice Prefix  

For more information please refer at Simulation: Schematic symbols: prefixes and pin numbers
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Component Adjust  

Adjusting Components

About adjusting components you can:

1. Move components with your mouse
2. Move components with the arrow keys.
3. Find components with the Design Manager via the CTRL+D  hotkey: select the component in 

the Design Manager to pan it to the centre of the canvas and then move it with your mouse.
4. Align the components:

 

Rotating the Prefix and Value (Name) of components

The default Prefix and Value (or name) of EasyEDA components are horizontal. To change them 
to vertical like this...
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...Left click the prefix or value and when it is highlighted in red color, then press 
the rotation hotkey Space and you're done.

 

Components Prefixes  

Prefix Start  

In EasyEDA, at the first new schematic the prefix will start as U1/R1..etc, and EasyEDA support 
global unique prefix at multi-sheet now.

Prefix Conflict Error  

Sometimes, if you save a sheet to another project, when you convert a project to PCB, open the 
Design manager or run a simulation, you will get a Prefix Conflict error message.

In this schematic, you will find two components with the R4 reference designator, so you just 
need to change one to Rx where x is a unique number in that schematic.
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It may be tempting to backup a schematic into the same project as the original, however, if an 
attempt is then made to do Convert Project to PCB, you will get the Prefix Conflict error for every 
component.

In the above image, you can find the two identical copies of the same schematic, which when you 
Convert Project to PCB, EasyEDA will try to merge into a single schematic, so every item will have 
2 copies. 
To fix this, you just have to create a backup project and remove or better still save backup copies 
of your schematics to that project.

Annotate  

After creating a schematic, it is quite likely that you have component Prefixes (reference 
designators) that are in no particular order on the canvas. You may also have duplicates. You can 
automatically renumber/reset all the components' prefix by using the Annotate function.

Via: Edit > Annotate
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Various Annotate possibilities are available:

Re-annotate all: resets all existing annotation and then annotates all components again 
from scratch;
Keep existing annotation: annotates new components only (i.e. those whose reference 
designator finishes with ? like R? or U?).
Direction: Rows annotates across the schematic in a raster pattern from top left to bottom 
right; 
Cols annotates down the schematic in a raster pattern from top left to bottom right.
Annotate: applies the selected annotation actions. 

Note: Annotation cannot be undone! if you do not accept the result: close all of the affected 
schematics without saving. If you do accept the result: make sure you save all of the affected 
schematics.

Reset: if you want to reset all the reference designators to end with '?', just click 
the Reset button. After that, R1 will be R?, U1 will be U? etc.

Note: Reset does not reset annotation back to where it was before pressing the Annotate button.

 

 

Multi-Sheet  

EasyEDA does not support true hierarchical designs but it does support multi-sheet designs. 
You can put several schematics in one project with connections between made 
by NetLabels/netPorts. All nets in EasyEDA are global so if you create a netlabel  DATA0  in sheet A 
and then create a netlabel  DATA0  in sheet B, when sheet A and sheet B are in the same project, 
they will be connected.
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Multi-sheet designs(equivalent to a circuit spread over several pieces of paper), all schematics 
under the same project will be merged into one when be converted to PCB connecting in 
netlabel, netflag. 

You can click the Sheet tabs on the left-down corner to switch the Sheets, and right-click the 
sheet tab you can "Save as", check "Histories record", "Rename" and "Delete" the sheet.

If you want to arrangement the sheets order, you click the menu of the sheet icon: Move 
Forward/Move Backward.



Note: 
EasyEDA support global unique prefixes, when you place components in different sheet, the editor will 
auto annotate the prefix. If you save as a sheet to another project, please make all of the prefixes 
unique, if the Sheet A has a R1, and the Sheet B has a R1, then you will get a Prefix Conflict Error.

 

Design Manager  

With large schematics it can be hard to find the components quickly. Sometimes, you may make 
a mistake such as wiring to a wrong component pin. So you need a tool to help you out. Design 
Manager is just the tool.

Just press the CTRL+D  hotkey to open the Design Manager.
or click it via on the left navigation panel:

1. Filter: You can find your components or net name easily: for example, if you want to find 
all capacitances, you just need to type C ;

2. Components: Lists all the components in this schematic. Clicking on a Component item 
highlights that component and pans it to the center of the window.

3. Nets: Lists all the nets in this schematic. A net must connect at least two Pins, or the net 
name will be marked as a red error.

4. Net Pins/Parts Pins: Lists all the pins of the selected net name or components.

If you click the Part's Pins or Net Pins, EasyEDA will show you where it is with a temporary marker 
from the top left of the canvas:
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Footprint Manager  

Introduction  

Want to batch modify components? Can't identify the corresponding relationship between 
component pins and footprint pins? Don't worry, EasyEDA can do this.

There are two ways to open the footprint manager:
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Click top toolbar Tools icon:

 

Click the footprint input box of custom attributes when you've selected a component:

1. Footprint manager will check your parts footprint correct or not automatically.  If the part 
without the footprint or this footprint doesn't exist in EasyEDA Libraries, or if the part's Pins 
doesn't correspond the footprint's Pads correctly, the footprint manager will show the red alert.   



For example, If your part D1 has 2 pins, pin numbers are 1  and 2 , pin names are A  and C , but 
you assigned a footprint has 2 pads, pad number are A  and C , but the part's pin number 
doesn't match the pad number, so the the footprint manager will alert red:

In order to solve this:

method 1: change part's pin number to A and C.
method 2: change footprint's pad number as 1 and 2. That needs the footprint is created by 
you. And you can't change the Pad number in footprint manager, you need to find out the 
footprint at "Libraries > Footprints > Personal", and then edit it.
method 3: find an other footprint and update.  

2. In the preview area, you can zoom in, zoom out and pan with mouse.

https://docs.easyeda.com/en/PCB/PCB-Tools/index.html#Pad
https://docs.easyeda.com/en/Schematic/Component-Attributes/index.html#Pinmap-Modify-Symbol-Information


Component PIN Information: And you can modify component's pin map information in 
here. 
PCB PAD Information:You can check the footprint's pad number, but you can't modify it. 
when you select the component on the left side, it shows component's footprint pad 
number, if you selected a footprint which is searched or selected from the classes, it will 
show the selected footprint's pad number.

 

Update footprint  

If you want to change the footprint, for example, select a component such as Q1, from TO-
92 TO TO220, you just need to click in the footprint input box. EasyEDA will popup the footprint 
manager dialog. You can follow the instructions. 

Type TO220 into the search box and search, Or change to Select tab,   
Select the classes you want and select TO220 footprint,   
Verify it in the preview box,  
then press the Update button.   

After that you will find you have changed the footprint to TO220.

Note: 

To ensure that you use a footprint type that is already in the EasyEDA libraries, it is recommended 
that you use this technique to change component footprints rather than just typing a footprint 
directly into the footprint text box, otherwise, you can't use the Update from Libraries  and 
Import Changes  function in the PCB, because of the footprint manager will add the footprint's 
global unique ID into the schematic when the footprint updating.

When you select a subpart, the others subparts will be selected too, so they will update the 
footprint together.
If the part's property "Convert to PCB" is set as "No", it will not appear at footprint manager.

Batch Update  
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If you want to batch modify components' footprints, in the footprint manager dialog you can 
press CTRL + click  or SHIFT + select  to select the components, and then select the footprint 
to update.
To use your own footprints, you can select Personal on Pattern Libraries area under the Select 
tab.

 

 

Find Similar Objects  

Find Components in the Schematic  

Finding individual components in a dense schematic can be very time consuming. EasyEDA has 
an easy way to find and jump to components:

Topbar > View > Find…

(or Ctrl+F )

Note: You have to click OK?in this dialog or use the Enter key.

This feature will find, highlight and center in the window, parts by their Prefix (or reference 
designator). ?However, it cannot be used to find net names or other text in a schematic.

This is where the Design Manager?comes in.

Left Navigation Panel > Design Manager, or use hotkey ctrl+D .

The Schematic Design Manager?is a very powerful tool for finding components, nets and pins.

Clicking on a Component item highlights the component and pans it to the center of the 
window.
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Clicking on a Part pins?item brings up a temporary pointer:

Find Similar Objects  
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EasyEDA provide a powerful find similar tool, you can find what you want very easily.
Via Topbar > View > Find Similar Objects…

Kind: Select the object what you want to find.
Range: This option only for the schematic, you can find the object for current sheet or all sheets.
Find Parameters: Any: Find any objects; Same: Only find the object which attribute same as this 
attribute. Different: Find the object which attribute is different than this attribute.



The input box support the Js Regular Expression, you can type /word/  to find what you want, 
such as find all prefix which are including "R": 

After click the "Find" button, all the siutable objects will be seleted, and the right-hand panel will 
show all the attributes, the different attributes will show as the <...> , you can change the 
attributes directly, and they will apply to all selected objects.

The find similar objects only support to find a part of custom attributes. Such as footprint, 
suppiler etc.

Convert Schematics to PCB  

Convert to PCB  

Most of the time, schematics are created with the aim of producing a PCB. So how do you convert 
your schematic to a PCB in EasyEDA? You just need to to click the PCB icon on the toolbar with 
the title Convert to PCB.  

Note: Before converting, you need to use the Design Manager and Footprint Manager to check all the 
components, nets(connection) and footprints to ensure no errors exist.
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Footprints Verification  

After clicking the Convert to PCB button, if the project has errors the following dialog will open:

The row in red indicates that EasyEDA can't find a PCB footprint matching the footprint that the 
schematic symbol is calling for.   

This could be because you have made an error entering the footprint attribute in the symbol's 
Properties or maybe you haven't yet created a PCB footprint for the footprint that your symbol is 
calling for.   

In this case the footprint should have been AXIAL-0.3 but instead it is empty. To correct it you 
can click on the row and update the footprint AXIAL-0.3 for it at the footprint manager.

After making any necessary corrections, click the Convert to PCB button and EasyEDA will 
automatically load all the PCB footprints into the PCB editor as shown in the image below.
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This shows the footprints placed in arbitrary positions with the connections between them 
shown as blue Rat lines.

Invalid footprint  
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The footprint's PAD number is different from the symbol's PIN number, e.g. the diode footprint's 
PAD numbers are A,C but the symbol's PIN numbers are 1,2. You just need to change one to fit 
the other. It is case sensitive!

the changing method please refer the Schematic - Footprint Manager section.

Update PCB  

Converting a schematic to PCB can be done using the Convert Project to PCB...  , but if you 
do modifications to the schematic, by using the Update PCB  button you can immediately be 
passed forward to update the selected PCB without having the PCB editor window already open 
or without creating a new PCB file. 

    

 

 

Cross Probe  
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This tool is used to cross probe from chosen objects on the current schematic to its 
corresponding counterparts in the PCB, or from PCB Footprints to corresponding counterparts in 
the schematic. 

  

Note: 

You don't need to open PCB first before using cross probe in the schematic. Editor will open the 
PCB automatically.
And don't forget to use the hotkey SHIFT+X .  
After converting the schematic to PCB, for using this function please save the PCB first.
If your project has many PCBs, when you use the cross probe that will open the first PCB 
automatically.

 

Cross Probe And Place  
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If your schematic have a lot of components, it will be difficult to layout the PCB , so EasyEDA 
provides a powerful function "Cross Probe And Place".

Topbar > Tools > Cross Probe And Place

Cross Probe And Place will make the footprints' location match the schematic's parts' location as 
much as it possibly can.

How to use: 

Convert the schematic to PCB first, and save at current project.
Select the components area by mouse in the schematic, and then click the "Cross Probe And 
Place", hotkey "CTRL + SHIFT + X".
The editor will switch to the PCB, and choose the footprints as you selected for waiting for 
placing.
Right click to place, and the mouse will keep the drag status, its easy for adjusting the 
footprints' location.

Notice:

You don't need to open PCB first before using this function in the schematic. Editor will open the 
PCB automatically.  
If your project has many PCBs, and didn't open anyone yet, the editor will open the first one 
automatically; If you already open a PCB, and this function will be valid for this PCB.
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Global Delete  

If you feel your schematic or PCB is mess up, need delete objects in batch, you can:

Edit > Clear，or CTRL + A select all and then press Delete key.
Delete the document and create a new one.  
Using Edit > Global Delete, just delete what you want.  

 

 

 

Schematic Modules  

Copying codes is an easy job for coders, now copying and reusing a schematic or PCB is easy.
Take a power supply unit for example, you can save this unit as a schematic module.
Via Document > Save as Module:
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This only save the current sheet to be the module.

After saving, you can find it at the Libraries > SCH Modules > Personal section. And you can 
place the whole block to your schematic.

 

                    

Schematic Theme  

EasyEDA support a powerful theme feature for the schematic design.

Via: Topbar - Theme.

Original Theme：The default theme, only works for the new part placing.
White on Black：White on Black, the objects will be white, the background will be black.
Black on White：Black on White.
User Definded：When change to this theme style, the schematic will follow your theme options 
"My theme".
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My Theme：Custom theme, which is stored locally in the browser and it will be synchronized to 
the server. When click apply, this theme will be applied to the current schematic. Next time you 
open the schematic, the theme of the schematic will be a custom theme.
My theme Settings：You can apply "My theme" on: 1. Creating New Schematic, 2.Opening 
Existed Schematic.

Your schematic theme will synchronized to the server by default.

 

                     

Export BOM  

You can export the Bill of Materials (BOM) for the schematic (Document) and PCB，click the top 
toolbar BOM  icon:

After clicking the BOM export option, the dialog below will open.

In this dialog，you can click the pencil icon to assign LCSC part's order code for your 
components.
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After clicking on the assign icon，the components and footprints search dialog will pop up, and 
you can choose which component you want to assign.



When you click the "Order Parts/Check Stock" button, we will help you to list all the components 
of your BOM at LCSC.com(If you haven't login LCSC, you have to login first). If you want to buy the 
components form LCSC, and you just need to put them to the cart and check out.

You can open the BOM in any text editor or spreadsheet.

Notice:

If your project has schematic and PCB, the BOM data will come from schematic; if the 
project only has PCB, the BOM data will come from PCB.
In order to support multiple languages, BOM and coordinate files (CSV file) are UNICODE 
encoded and tab-based. If the CSV file cannot be read by your components vendor or PCB 
manufacturer, please convert the encoding and change the delimiter.
Recommended solution: Save as a new CSV file in Excel or WPS. For example, open a CSV file 
in Excel, click or select: Save As - Other Formats - CSV (Comma Separated) (*. csv).
You can also open the CSV file with any text editor (such as Windows Notepad) and save as 
ANSI or UTF-8 encoding. If necessary, replace all tabs with commas.

 

 

Export NetList  

EasyEDA can export the netlist for the whole active project:

Document > Export NetList > Spice...

EasyEDA can export a netlist in a variety of formats: 
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Spice: this is a Spice3f5 compatible netlist generated by the simulation engine of EasyEDA, 
Ngspice. It is not normally used as the basis for as a PCB layout.
Altium Designer: a PCB netlist in a format that can be imported straight into Altium 
Designer and it's predecessor, Protel. 
Pads: a PCB netlist in a format that can be imported straight into Pads PCB layout tools.
FreePCB: a PCB netlist in a format that can be imported straight into FreePCB, a  free, open 
source PCB editor for Windows.

 

Report Error  

For EasyEDA official libraries, we have staffs to draw and maintain(LCSC & LCSC Assemble part) 
and we will try to keep them correctly as we can, but EasyEDA(System part) included a lot of open 
source of the libraries and the official drawing of the libraries, that can not avoid the wrong 
situation 100%, so when you meet a incorrect library, Please inform us in time, we will fix it as 
soon as possible.

There are 3 ways to report error:

http://www.google.com/url?q=http%3A%2F%2Fngspice.sourceforge.net%2Fpresentation.html&sa=D&sntz=1&usg=AFQjCNEvVOggHskD819G-5EW8EB59FL5mw
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1.Right-click the offical library and use the "Report Error" function on the "Libraries".

2.Select the offical library on the canvas of the schematic/schematic module, click the "Report 
Error" button at the right-hand panel.

3.Send Email to us support@easyeda.com  or post a topic at Bug report

                     

Create the SchematicLibs  

Create the SchematicLibs  

Using Schematic Symbol Wizard and Group/Ungroup... is a quick way to create schematic 
symbols but they are placed directly into the schematic that they are built in. 

It is possible to reuse them by copying them ( CTRL+C  hotkeys) from the schematic they were 
created in and then cross-document-pasting them ( CTRL+SHIFT+V  hotkeys) into a different 
schematic but this quickly gets messy if you need to copy symbols that were created in several 
different schematics. 

OK, you could keep copying new symbols into a dedicated “symbol library” schematic sheet to 
save searching for them but EasyEDA offers you an easier way to create and manage your 
symbols in a library.

Start a new Schematic Lib as shown below or by doing:

https://easyeda.com/forum/category/2
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1. Document > New > Schematic Lib 

 

This opens the New SchematicLib symbol editor.

2. Create the symbol

Get the Datasheet 
For example, using the NE555DR, the datasheet you can refer LCSC: NE555DR.
And then create the symbol and place the pins for the library base on the datasheet. 
This component have 8 pins and names. 

Create via Schematic Symbol Wizard 

 

The more information of Schematic Symbol Wizard please refer next section.

Create by Manually

https://datasheet.lcsc.com/szlcsc/NE555DR_C7593.pdf


Draw the shape via the Drawing Tools

 

Place the Pins

 
The Pin dot must keep out side as the image indicated, it is connecting with the wires. 
The more information please refer SchematicLib Attributes - Pins Section.



3. Edit the pin map
Via Edit > Pin Map..., change Pin names and Pin numbers. For some complicated IC, will use the 
alphabet for the pin number. 

4. Modify the Detail
such as change Pin length, place text, change Pin color, Pin attributes etc.

5. Set Costom Attributes
You can set the supplier, footprint(Suggested, you must assign the footprint via "Footprint 
Manager"), Name(Required), Prefix(Required) for it, the more detail of attributes please refer 
below section: Custom Attributes



If the schematiclib need to assign the packahe, the Pin number should match the footprint's Pad 
number. The detail of the footprint assign please refer the Footprint Manager section at 
previous.

If the part's property "Convert to PCB" is set as "No", it will not appear at footprint manager.

6. Set the Origin
You can via: "Topbar - Place - Set Canvas Origin - By Center Grid of Symbols" to set the origin.

7. Save your SchameticLib
You can set this library's owner, datasheet link and tags etc. 



Then a Schematic Symbol is created finish. And the you can find it at "Libraries - SchematicLib - 
Personl" on the left-hand.

Notice:

Note the Origin Point. To simplify rotating your symbols when they are placed into the 
canvas, make sure all of your symbols are created as near as possible centered around that 
point. Suggesting the first Pin/Pad or its center to be the origin point. 
Please make sure all pins dot are placed on the grid, otherwise, when place the library on the 
schematic will causing the wiring difficult.

SchematicLib Subparts  

We have already touched on how EasyEDA can support Multi-part Components  but how do 
you create multi-part components?

EasyEDA provides a sub parts facility to do this.

After creating a part, you can right-click the part in the Libraries > Symbols > Personal > 
Created section to pop up the content menu.

Suppose you have created your own symbol for a 74HCT04 hex inverter.

Right Click Add sub part and that will add 74HCT04.1,  

Click again to add 74HCT04.2 , up to 74HCT04.6. 

Then double click on each sub part in turn to modify the Pin Name and Number attributes.

Easy or what?
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Pin Attributes  

Symbols pins are the most important part of any Schematic Lib symbol. They are the things that 
allow wires to be attached to symbols to connect up your circuit.

You can use the P hotkey to add a Pin or from the Draw Tools pallete:

Before placing it on the canvas, you can use the rotation hotkey or rotate and flip from the menu 
to rotate it to the right orientation. Make sure the Pin Dot(black dot) is in the right position. The 
Pin Dot will be used to connect your wires or netlabels. Whenever a PIN is either placed as 
directly onto the canvas or as part of a symbol, the mouse has to point to the Pin Dot position to 
automatically start the Wire mode or to join a wire to it.

Whenever a Pin is placed as part of a symbol, the Pin dot should be outside of — and pointing 
away from — the symbol like in example 1(correct position), inside or pointing towards 
the symbol as shown in example 2(wrong position).
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When you select a single Pin, the Pin attributes will be shown in the right hand Properties 
panel:

Orientation: 0°,90°, 180° and 270°。If you want to create a 45° pin, you need to set it length as 
0, and draw a line with 45°。

Start-X and Start-Y: The pindot position. Sometimes it may be difficult to move the pin to the 
desired position using the mouse, so you can move the pin via Start-X and Start-Y.

Length: Pin length.

Name: In this example, VCC is the name of the Pin.



Number: In this example, 1 is the number of the Pin. This number is the pin number of the 
device in a physical footprint.

Note that you can use alphanumeric identifiers such as; A1, B1, C1, A2, B2 and so on as the 
Number.

Spice Number: These are the pin numbers used to connect your symbol to the corresponding 
pins defined by the .model or .subckt used to simulate your device. The pin numbers of the 
simulation model may be different from the physical footprint pin numbers and - unless the 
model is specifically created to model multiple devices in a single footprint - do not change for 
different instances of a device in a multi-device footprint. The Spice Pin order must be numerals 
only.

Name Display: If you don't want to show VCC, switch it to NO.

Number Display: If you don't want to show 1, switch it to NO.

You can adjust the Name or Number position using your mouse but note that rotate and flip 
applies to the whole pin including the name and pin number; these items cannot be rotated and 
flipped independently of the pin itself.

Note also that rotate and flip actions do not result in upside down or mirrored pin number or 
names.

Color: You can set the Pin to different colours, such as PIN3:CLK as orange and PIN4:GND as blue. 
In this example, the PIN1 is set as color #880000 , but it shows as red, because it is selected. After 
deselecting it, the pin will appear color #880000 .

Dot: adds a circle to the inside end of the pin to indicate logical (or analogue) inversion.

Clk: adds a >  to the inside end of the pin to indicate that the pin is logical clock input.  



Show: YES/NO. Allows you to hide the pin. When set it to NO, this Pin will be hidden when the 
symbol is placed on the schematic editor canvas, and then create a net which name same as this 
pin name.

Note that the pin is not hidden here in the Schematic Lib symbol editor canvas because if it was, 
it would disappear from view and so how would you find it to make it visible again? For the same 
reason this option has no effect in symbols made using Group/Ungroup…

We may not have thought of everything in EasyEDA but we do try.  :)

Electric: [Undefined, Input, Output, I/O, Power] 

EasyEDA provides Electrical Rules Checking (ERC) right now, But you still need to set electric of 
your Schematic libs. 

If you set the PIN as Power and set the pin to be hidden, then the Pin will be connected by 
Name which is the NetLabel. If the Name is VCC, it will be connected to the net in your circuit with 
the NetLabel or NetFlag VCC. This is helps to keep the schematic clear and uncluttered when 
using Multi-part Components.

After created the Lib, use  CTRL+S  will open the save dialog:



After clicking Save, you will see it appears in Libraries > Symbols > Personal of the left hand 
Navigation panel.

If you want to modify the tag for your new symbol: Libraries > Symbols > Personal > Select 
New Lib > More > Modify, or right-click new Lib > Modify, if your Lib doesn't have the tags it 
will appears on All.

 

Custom Attributes  

In the Schematic Lib editor's canvas Properties panel, you will find a Custom Attributes section:
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footprint

How to change Schematic Symbol's footprint? If you would like to built a PCB, you need to assign 
a footprint for your Schematic symbol. Although there are other ways to do this in EasyEDA, here 
is the right place to do it. When you set a footprint , the footprint's pad numbers must match 
the  schematic Lib's pin number, otherwise,  when you convert the schematic to PCB , there will 
miss several nets.

Click in the footprint input box, and the  Footprint Manager dialog will open as used to do this 
task in the Schematic Editor.

The more information please refer to Schematic - Footprint Manager section.

Notie: 
You have to assign the footprint via the Footprint Manager, otherwise, the Schematic lib will not get the 
footprint correctly. The footprint is linked with SchematicLib by global unique ID not the title.

Prefix

The default Schematic symbol Prefix is U? If you create a resistor, you can set the Prefix to R?. It is 
filled required. 

Name

You can change the schematic lib's name here, it is can be different from the part's file name.

Contributor

This is your registered user name. When Other EasyEDA's users use your libraries, they will 
remember your contributions!  

Symbol Subparts  

 

We have already touched on how EasyEDA can support Multi-part Components  but how do 
you create multi-part components?

EasyEDA provides a sub parts facility to do this.

After creating a part, you can right-click the part in the Libraries > Symbols > Personal > 
Created section to pop up the content menu.

Suppose you have created your own symbol for a 74HCT04 hex inverter.
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Right Click Add sub part and that will add 74HCT04.1,  

Click again to add 74HCT04.2 , up to 74HCT04.6. 

Then double click on each sub part in turn to modify the Pin Name and Number attributes.

Easy or what?

 

 

Schematic Symbol Attributes  

Pin Attributes  

Symbols pins are the most important part of any Schematic Lib symbol. They are the things that 
allow wires to be attached to symbols to connect up your circuit.

You can use the P hotkey to add a Pin or from the Draw Tools pallete:

Before placing it on the canvas, you can use the rotation hotkey or rotate and flip from the menu 
to rotate it to the right orientation. Make sure the Pin Dot(black dot) is in the right position. The 
Pin Dot will be used to connect your wires or netlabels. Whenever a PIN is either placed as 
directly onto the canvas or as part of a symbol, the mouse has to point to the Pin Dot position to 
automatically start the Wire mode or to join a wire to it.
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Whenever a Pin is placed as part of a symbol, the Pin dot should be outside of — and pointing 
away from — the symbol like in example 1(correct position), inside or pointing towards 
the symbol as shown in example 2(wrong position).

When you select a single Pin, the Pin attributes will be shown in the right hand Properties 
panel:



Orientation: 0°,90°, 180° and 270°。If you want to create a 45° pin, you need to set it length as 
0, and draw a line with 45°。

Start-X and Start-Y: The pindot position. Sometimes it may be difficult to move the pin to the 
desired position using the mouse, so you can move the pin via Start-X and Start-Y.

Length: Pin length.

Name: In this example, VCC is the name of the Pin.

Number: In this example, 1 is the number of the Pin. This number is the pin number of the 
device in a physical footprint

Note that you can use alphanumeric identifiers such as; A1, B1, C1, A2, B2 and so on as the 
Number.

Spice Pin order: These are the pin numbers used to connect your symbol to the corresponding 
pins defined by the .model or .subckt used to simulate your device. The pin numbers of the 
simulation model may be different from the physical footprint pin numbers and - unless the 
model is specifically created to model multiple devices in a single footprint - do not change for 
different instances of a device in a multi-device footprint. The Spice Pin order must be numerals 
only.

Name Display: If you don't want to show VCC, switch it to NO.

Number Display: If you don't want to show 1, switch it to NO.



You can adjust the Name or Number position using your mouse but note that rotate and flip 
applies to the whole pin including the name and pin number; these items cannot be rotated and 
flipped independently of the pin itself.

Note also that rotate and flip actions do not result in upside down or mirrored pin number or 
names.

Color: You can set the Pin to different colours, such as PIN3:CLK as orange and PIN4:GND as blue. 
In this example, the PIN1 is set as color #880000 , but it shows as red, because it is selected. After 
deselecting it, the pin will appear color #880000 .

Dot: adds a circle to the inside end of the pin to indicate logical (or analogue) inversion.

Clk: adds a >  to the inside end of the pin to indicate that the pin is logical clock input.  

Show: YES/NO. Allows you to hide the pin. When set it to NO, this Pin will be hidden when the 
symbol is placed on the schematic editor canvas.

Note that the pin is not hidden here in the Schematic Lib symbol editor canvas because if it was, 
it would disappear from view and so how would you find it to make it visible again? For the same 
reason this option has no effect in symbols made using Group/Ungroup…

We may not have thought of everything in EasyEDA but we do try.  :)

Electric: [Undefined, Input, Output, I/O, Power] 

EasyEDA provides Electrical Rules Checking (ERC) right now, But you still need to set electric of 
your Schematic libs. 



If you set the PIN as Power and set the pin to be hidden, then the Pin will be connected by 
Name which is the NetLabel. If the Name is VCC, it will be connected to the net in your circuit with 
the NetLabel or NetFlag VCC. This is helps to keep the schematic clear and uncluttered when 
using Multi-part Components.

After created the Lib, use  CTRL+S  will open the save dialog:

After clicking Save, you will see it appears in Libraries > Symbols > Personal of the left hand 
Navigation panel.



If you want to modify the tag for your new symbol: Libraries > Symbols > Personal > Select 
New Lib > More > Modify, or right-click new Lib > Modify, if your Lib doesn't have the tags it 
will appears on All.

 

Custom Attributes  

In the Schematic Lib editor's canvas Properties panel, you will find a Custom Attributes section:

footprint

How to change Schematic symbol's footprint? If you would like to built a PCB, you need to assign 
a footprint for your Schematic Symbol symbol. Although there are other ways to do this in 
EasyEDA, here is the right place to do it. When you set a footprint , the footprint's pad numbers 
must match the  schematic Lib's pin number, otherwise,  when you convert the schematic to 
PCB , there will miss several nets.

Click in the footprint input box, and the  Footprint Manager dialog will open as used to do this 
task in the Schematic Editor.

The more information please refer to Schematic - Footprint Manager section.

Notie: 
You have to assign the footprint via the Footprint Manager, otherwise, the Schematic lib will not get the 
Footprint correctly. The footprint is linked with SchematicLib by global unique ID not the title.

Prefix

The default Schematic symbol Prefix is U? If you create a resistor, you can set the Prefix to R?. It is 
filled required. 

Name

You can change the schematic lib's name here, it is can be different from the part's file name.
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Contributor

This is your registered user name. When Other EasyEDA's users use your libraries, they will 
remember your contributions!  

 

Schematic Symbol Wizard  

How many times have you hit a schematic capture roadblock because you couldn't find 
a component symbol?

Well, in EasyEDA that would be never because the Schematic Symbol Wizard provides a quick 
and easy way to create a general Schematic Symbol symbol.   

The Schematic Symbol Wizard... command can be found in the top toolbar. 

 

Basic Function  

Input the Pins' name Only  

1. Using the NE555 timer as an example: this device is available in a DIP8 package so select 
DIP. Then enter the NE555 pin names into the Pin Names text box separated by new line or 
space, Then press OK. Abracadabra! As if by magic, you will find a perfectly formed dual in 
line 8 pin symbol for the NE555 attached to your mouse cursor, ready to be placed! You just 
need a few seconds to build a NE555 symbol, quickly and easily.

2. The EasyEDA Schematic Symbol Wizard allows you to create DIP, QPF or SIP styles symbols. 
If you are designing Arduino Shields then you will need lots of SIP symbol, so you can create 
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a SIP symbol like the one shown below in a few seconds.

3. If you are not too worried that the symbols may not look quite the way people might expect 
and that they may not look anything like the Type you select, then of course you can use the 
wizard to create symbols for any component:

Input the Pins' number and name  

Schematic Symbol wizard support you input the pins' number and name.
As below example, setting every pin's number is easily.

 

Professional Function  

Schematic Symbol Wizard support the professional function, it is easier to create the large and 
complex and more convenient Schematic Symbol.

1.Download Schematic Symbol Wizard Template.xlsx
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2.Open it via Excel or WPS, and edit each Pins attributes and position, and then copy the content 
and paste in wizard dialog without content title. 
Tip: If you want to create the gap between Pin and Pin, you can use the *  as below image.

3.The Wizard will create the symbol follow your content. The types you chosen will be ignored.

Notice:

If the content you input wasn't one, two or eight columns, it will shown incorrect format.
You can use the Key Space to separate the column data.

 

Edit Exited Schematic Symbol  

Personal Libraries  

When you CTRL+S  to save the Schematic Symbol, will pop up a dialog, you can choose this 
library's owner:
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After finish, you can find your library at the left panel: Libraries > Symbols > Personal/Team > 
All

Tag

When you select it , right-click it and select the menu "modify", you can add a tag for it.

Favorite

When you favorite a library, you can find it at Libraries > Symbols > Personal > Favorite  , If this 
library has a tag, the tag will show up too, but you can't edit that.
But you can via "Clone" or "Edit and save" to create a new library to personal libraries.                   

 

Edit SchematicLib in the Libraries  
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When you feel the Schematic Libs can not be satisfied for you, you can edit it.

Via "Libraries" > "Search Part/Personal/LCSC/System" > Select Schematic Lib > Edit

when you finish and save, it will be saved to your personal libraries Personal and become your 
personal libraries.

Edit SchematicLib in the Schematic  

If you want to edit a symbol in the schematic, you can use the Ungroup/Group function.

On the Wiring Tools palette there is the Group/Ungroup Symbol… button.

This tool is for you to quickly create or edit schematic library symbols.

1. Select a symbol
2. Click the Group/Ungroup Symbol… button

Up to this point you have a collection of separate pins, a drawn rectangle and some text that 
are all separate items with no particular association with each other.

3. Edit the shape or pin what you want to change
4. Select all of the items and click the Group/Ungroup Symbol… button. 
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A dialog will be opened:

After you click OK, all those separate elements will be grouped together to form your new symbol 
directly in the schematic.

Using the group function, you can create/edit any symbol in the schematic, easily and quickly.

Note: 

The pin numbers and names cannot be moved independently of the pin.

If it's still difficult to understand, don't worry, you can see the process in the dynamic image 
below:

   

Canvas Setting  

After the initial conversion of a schematic to PCB, it is time to learn how to manage EasyEDA's 
PCB Design Editor.

Canvas Attributes

Lots of PCB canvas attributes are the same as Schematic canvas attributes. The key is that you 
can set units in PCB canvas attributes.
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When you select a object at the canvas, you can modify its attributes at the right panel.

Other

Routing Width: Setting the default routing width.
Route Angle: Setting the routing angle.
Copper Zone: Setting the copper zone visible or invisible.

PCB Tools  

PCB tools provide many function to fulfill your PCB design requirement.
Such as: Track, Pad, Via, Text, Arc, Circle, Move, Hole, Image, Canvas Origin, Connect Pad to Pad, 
Copper Area, Solid Region, Measure/Dimension, Rect, Group/Ungroup. etc.
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Track  

In the schematic editor, we use Wire or the W  Hotkey to connect Pins, in a similar way in the PCB 
editor, we use Track to connect Pads. Track allows you to draw PCB tracks and can be found on 
the PCB Tools palette or using the W  Hotkey (not T: see above!).

When a track is selected, you can find its Length attribute in the right panel.

  

If you want to create solder mask for the track, you can click the "Expose Copper" button at the 
right-hand property panel.

The more information of routing, please refer at PCB: Route Tracks

 

Pad  

You can add pads using the Pads button from the Footprint Tools palette or using the P  hotkey.
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After selecting one of the pads, you can view and adjust its attributes in the right hand 
Properties panel.

Number: Remembering the pin numbers you set in the schematic symbol in your Schematic 
Lib: to connect those schematic symbol pins to the pads in your PCB footprint, the pad numbers 
you set here in the Footprint footprint must be the same.

Shape: Round , Rectangular ,  Oval and Polygon.

EasyEDA supports four shapes: Round  ,  Rectangular  , OVAL  and POLYGON .  

OVAL  PAD will give your more space.   
POLYGON  PAD will let you to create some strange pad.  



Like in the image below, you can edit the PADs points when you select a POLYGON  PAD

Layer: If the pads are part of a SMD footprint, you can set it to Top layer or Bottom layer. For 
through hole components you should set it to Multi-Layer. If it setting as mult-layer, it will 
connect with all copper layers.

Net: You don't need to enter anything here because at present this footprint is not connected to 
anything in a circuit.

Width and Height: When the shape is set to Round, Width will equal Height.

Rotation: Here you can set the Pad's rotation as you want.

Hole(D):  This is the drill hole diameter for a through hole pad. For a SMD Pad, set its layer to 
TopLayer or BottomLayer.

Center-X and Center-Y: using these two attributes, you can set the pad's position with more 
precision, compared to using the mouse.

Plated： Yes or No. When you set it as No, this pad Inner wall do not metallization.

Paste Mask Expansion: For single layer pad. This property affects the size of the tin area on the 
plate of the steel mesh. If you want to set a pad that is not open in the steel mesh, you can set 
the value to be negative, which is usually larger than the diagonal of the pad.

Solder Mask Expansion： This property affects the size of the green oil area cover on the pad. If 
you want to set a pad not open covered with green oil, you can set the value to be negative, the 
value is usually set larger than the diagonal of the pad.

 

Via  

When you want to lay a multilayer PCB, you need to add Vias for nets getting through layer and 
layer.

Place a Via On a Track
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When placing a via  on a track, the track will be cut to two segments.  Placing two vias on a 
tracks, you will get three segments, then you can change one segment to other layer id, or 
remove one of them. 

 

Notice: 

EasyEDA only support the through via for all layers, doesn't support the Buried hole/via. 

Text  

You can add more fonts from your computer or download some free 
fonts:www.1001freefonts.com and free fonts: http://www.fontspace.com/.

if you need Japanese or Korean you can use Google Noto fonts

Select the text, then you can find a Font-family attribute on the right panel like in the image 
below.
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Click the add button, then choose the font, the font file must be ttf  or otf .

  

So you can add any fonts by yourself. EasyEDA doesn't cache the font on our server, so if you 
close the editor, you need to add the font again by yourself.

Note: If you use the other font, the LineWidth  attribute is useless, because it will be automatically set 
by changing the Height .

 

Arc  

You can draw many Arcs with different sizes, it's easy to create a pretty cool PCB as you like.  

  

EasyEDA provides two Arc tools:
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Start point fixed, you can change the end point position and radius.

Center point fixed, you can change the radius.

Circle  

You can draw a circle in PCB , but it can only be drawn at SilkLayer and Document Layer. If you 
want to draw a circle at TopLayer or BottomLayer, please use Arc.
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Move  

This option is same as schematic's drag.

Hole  

There were lots of users that didn't know how to use PAD or VIA as a HOLE, they asked EasyEDA 
for help, so EasyEDA added a HOLE TOOL in the PCB toolbar.

And if you want to create the slot hole, you can use solid region(Type: NPTH), or route a track, 
and then right-click the "Convert to NPTH" menu.

Image  

On PCB and Footprint editor, there is a nice feature on the PCB Tools bar.
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After clicking on the image icon, you will see the Insert Image window as below.

In this dialog, you can choose your favorite image, EasyEDA support JPG , BMP , PNG , GIF , and 
SVG . Unlike some other EDA tools which only support a Monochrome Bitmap image, EasyEDA 
supports full color, but Monochrome Bitmap is welcome.

You can adjust the color tolerance, simplify level and reset the image size there.

And you can select shape invert. 

The image will be inserted to the active layer, if it is not right, you can change the attribute. Such 
as TopSilkLayer.  
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Canvas Origin  

This option is the same as schematic's Canvas Origin.

Protractor  

We provide a protractor for PCB tools.

Connect Pad to Pad  

When creating a PCB without a Schematic, none of the pads on the Footprints have nets 
connecting them so there will be no ratlines. 

Rather than try to track the pads from scratch, it is a good idea to connect them up by hand first 
using  Connect Pad to Pad  from the PCB Tools palette. This will help you to remember to track 
the pads correctly with fewer mistakes.   

You could also do this by setting net names for all the pads: if the two pads are given the same 
net name then EasyEDA will understand that they are connected together and will automatically 
create a ratline between them.  
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Or you can set these two pads with the same net name at the right panel Pad Properties after 
you click the pad.

This tool only works for footprint's pad, the single pad you placed in the PCB can't be connected 
by this tool.

Copper Area  

Sometimes you will want to fill in or flood an area with copper. Usually this copper area will be 
connected to a net such as GND or a supply rail. You can draw the outline of a flood using the 
Copper Area button from the PCB Tools palette.

When selecting a copper area, you can find its attributes from the right hand Properties panels.
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The more information please refer at PCB: Copper Pour

Solid Region  

EasyEDA has added a new tool Solid Region for PCB design

This is a very useful, quick way to connect Pads. You can draw a Solid Region to include all of 
these pads with same net name, then set the region to the same net name as the pads. It is like 
Copper Area but easier to use for small areas. To use Solid Region like this, set the Type attribute 
(in the right hand Properties panel)  to Solid.

The more information please refer at PCB: Solid Region

https://docs.easyeda.com/PCB/Copper-Pour/index.html
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Measure/Dimension  

Making and adding measurements is useful in PCB design. EasyEDA provides two methods to do 
this.

1. Dimension tool in the PCB Tools palette:
  This tool can show three units on the canvas, milliliter, inch and millimeter.

  

  When you click one side of the dimension on the PCB, you can drag it for any directions or 
change its length.

  

2. Measure a distance using M Hotkey: press M, Or Via: Super menu > Miscellaneous > 
Measure Distance, then click the two points which you would like to measure.  
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  Note: This method will display the distance units which is the canvas' units.

  

Rect  

It looks like a Solid Region, but it can't be set Nets and you can't set the Layer as NTPH.

Group/Ungroup  
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Just like Group/Ungroup in the Schematic Editor can be used to create a schematic lib symbol, 
you can use Group/Ungroup from the PCB Tools palette to create a Footprint footprint in the PCB 
editor.

For example, place Tracks and Pads on the canvas, then select all of them and click 
Group/Ungroup to group them like in the image below:

Layers Tool and Objects  

Layers Tool  

Active Layer: The colours of the layers in the Layers Tool are defined in the Layer Options 
Settings. To work on a layer then you must make it the Active layer.    

To do this, 

Click on the eye icons to show/hide layers.  
The pencil icon in the coloured rectangle indicates that this is the active layer.   
Click the pin icon to fix the layering tool without automatically closing it.
The height and width of the layer tool can be adjusted when dragging the lower right corner 
of the Layers Tool.
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HotKeys for layer activation:  

T: Top Layer is active  
B: Bottom Layer  
1: Inner1 Layer  
2: Inner2 Layer  
3: Inner3 Layer  
4: Inner4 Layer  

The more information for the PCB layers please refer at PCB Layout - Layer Manager

note: the hidden PCB layer is only visually hidden. The corresponding layer will still be exported 
during photo preview, 3D preview and Gerber export.

Objects Filter Tool  

Click "Object" to switch to object filtering.

https://docs.easyeda.com/en/PCB/Layer-Manager/index.html
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Select： When the tick in front of the object is checked, the corresponding object in the canvas 
can be manipulated with the mouse. Uncheck will not allow mouse operation. Including click 
selection, box selection, drag and other operations.

Eye： Click eyes to modify the display and hiding of corresponding objects in batches. 

Component：Displays or hides the entire components, excluding the component's name 
and prefix
Prefix：Displays or hides the entire components' prefix
Name：Displays or hides the entire components' name
Track：Displays or hides the entire tracks, for all layers
Pad：Displays or hides the entire free pads, excluding the pads in the component
Copper Area：Displays or hides the entire copper areas' fill area, excluding copper outline
Text：Displays or hides the entire normal texts, excluding the text of the component

Note: The layer and object invisible and visible will not go into Undo and Redo.

 

Layer Manager  

Layer Manager  

You can set the PCB layer's parameters at the Layer Manager.

Via Topbar > Tools > Layer Manager..., Or Click Layers Tool gear icon. Or right-click the canvas - 
Layer Manager menu.

The Layer Manager dialog:
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The Layer Manager setting only works for the current editing PCB.

Copper Layer: The copper layer of your PCB. EasyEDA support 34 copper layers. The more 
copper layers the PCB will be more expensive. The TopLayer and BottomLayer is default layer, 
can not be disable. If you want change the copper layers from 4 to 2, you must delete the inner 
layers objects first.   

Display: If you don't want a layer dosen't display at "Layers Tool", you can disable the checkbox.  
Notice: This option only hide the layer name on the "Layers Tool", the objects of the hidden layer 
still exist, when you generating the Gerber, they will appear.

Name: Layers name. For the inner layer, you can define the name.  

Type: 

Signal: Which is working for the signal. Such as Top and bottom layer.
Plane: When the inner layer type is "Plane", this layer will be copper pourred, if you want to 
separate the copper area you can draw the Track or Arc. You can treat this layer is a only 
has the copper area, but its easy than draw the copper area. The track you routed will 
generate the clearance when generating the Gerber. The "Plane" usually is using for the 



Power or Ground copper pour on the inner layer. You can set the net for the plane zone. 

   

Notice: When draw the track to separate the plane zone, the track start ponit and end point must 
over the middle line of the board oultine track. Otherwise, the plane zone will not be separated; 
When using the plane layer, the PCB can not exist two closed borad outline, only one closed 
board outline will generate the plane zone.

Non-Signal：Such as silk screen, mechanical layer, document layer etc.

Color: You can define the color for each layer.

Transparency: You can change the layer transparency.

Layer Definination:

TopLayer/BottomLayer: The top side and bottom side of the PCB board, copper layer.
InnerLayer: Copper layer, routing track and copper pour.
TopSilkLayer/BottomSilkLayer: Board silkscreen.
TopPasteMaskLayer/BottomPasteMaskLayer: This layer is the layer used to make the 
stencil for the SMT pads, helping to solder. This layer has no effect on production if the 
board is not required to make the stencil.
TopSolderMaskLayer/BottomSolderMaskLayer: The top and bottom cover layers of the 
board are typically green oil, which acts to prevent unwanted welding. This layer belongs to 
the negative film drawing mode. When you have wires or areas that do not need to cover 
green oil, draw them at the corresponding positions. After the PCB is generated, these areas 
will not be covered with green oil, which is convenient for operations such as tinning.
BoardOutline: The board shape definition layer. To define the actual size of the board, the 
board factory will produce the board according to this shape.
TopAssemblyLayer/BottomAssemblyLayer: Simplified outline of components for product 
assembly and repair. Used to export document printing, without affecting PCB production.
MechanicalLayer: Record the information on the mechanical layer in the PCB design, and 
only use it for information recording. By default, the shape of the layer is not manufactured 
at the time of production. Some board manufacturers use the mechanical layer to make the 
frame when using Altium file to production. When using Gerber file, it is only used for text 
identification in JLCPCB. For example: process parameters; V cut path etc. In EasyEDA, this 
layer does not affect the shape of the border of the board.
DocumentLayer: Similar to the mechanical layer. But this layer is only visible in the editor 
and will not be generated in the Gerber file.
RatlineLayer: PCB network ratline display, this layer is not in the physical sense, in order to 
facilitate the use and set color, it is placed in the layer manager for configuration.
HoleLayer: Similar to the RatlineLayer. For Hole(Non-Plated Hole) display.



Multi-Layer: Similar to the RatlineLayer. For multi-layer hole(Plated hole) display. If the PAD 
setting layer property as mult-layer, it will connect with all copper layers.
DRCErrorLayer Similar to the RatlineLayer. For DRC(Design Rule Error) marking dispaly.

Layout Single Layer PCB  

The PCB copper layers of EasyEDA are double, EasyEDA doesn't support layout a signle layer 
directly. if you want to layout a single layer PCB(such as only layout on the bottom layer), 

There are two methods:

Method 1:

Route the track and copper on the bottom layer, and without placing via.
If you are using the footprints which have the multi-layer pads, that will appear on the top 
and bottom layer, then you need to change all multi-layer pads "Plated" as "No".
Generate the Gerber, decompress the Gerber zip file, delete the layers which you don't 
need(such as Gerber_TopLayer.GTL, Gerber_TopSilkLayer.GTO, 
Gerber_TopSolderMaskLayer.GTS, Gerber_TopPasteMaskLayer.GTP).
And re-compress the Gerber to a zip file, and order it.

Method 2:

Design your PCB at one side, if other side has pads etc, you don't need to deal with them.
Generate the Gerber.
Add the comment for mention that you need to order the signle layer PCB when order the 
PCB.

Ratline  

 

When you layout the track in the PCB, Between Pad and Pad as they have the same net name, a 
Ratline will be automatically shown among them to reveal that they can be connected with a 
track.
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1. If you want one ratline do not show on the PCB editor, you can deselect the net in the 
design manager, as below deselect +5V :
If you still draw a track in +5V  after deselecting, canvas will not display this track and ratline 
, but it will show a net text with +5V  as below.

Based on this skill， you don't need to lay GND net before copper area in the PCB.

2. If you want to check the ratlines with highlight, you can click the pencil on the Ratlines Layer 
as below, and you can change the ratline's color at Layer Manager.

3. If you want to hightlight one ratline all the time, you can click a pad, press hotkey H, press it 
again unhighlight.



4. If you want to change one ratline's color, you can set it at: Top Menu - Tools - Net Color. 
After setting the color, you need to click the plus icon on the right. The color is not affected 
by the color of the ratline layer.

5. If you want to remove one ratline, you just need to remove objects' net.

 

PCB Net  

Net Name Visible

PCB editor can display net name in the track or Pads, if you don't need this feature, just need to 
turn it off via： 

View > PCB Net Visible, or press hotkey Q  .

Net Length
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After selecting a track, and then pressing H  key, EasyEDA will highlight the whole net and pop a 
message box to tell you the whole net's length. like in the image below

Net Color

If you want to change one Ratline's or Net's color, you can set it at: Top Menu - Tools - Net Color. 
After setting the color, you need to click the plus icon on the right. The color is not affected by the 
color of the ratline layer.



Board Outline  

 

Before placing footprints we need to create a board outline. The board outline must be drawn 
on the Board OutLine layer. So first, set Board OutLine as the active layer, then draw the board 
outline using Track and Arc from the PCB Tools palette.

When converting a Schematic to PCB, EasyEDA will try to create a board outline for you.

The area of the default board outline area is 1.5 times the sum of the area of all of your 
footprints, so you can place all of your footprints into this board outline with some allowance for 
tracking. If you do not like the board outline, you can remove the elements it is made up from 
 and draw your own.

af://n2827


To create a simple rectangular board outline, this arc can be removed and the line X and Y end 
points edited - either directly in the Properties panel or by dragging the line ends - to close the 
rectangle.

Alternatively, an outline with more rounded corners can be created by copying the arc and 
rotating it in 90 degree steps to position it over the desired right angle corners and then editing 
the line X and Y end points - either by dragging the line ends or directly in the Properties panel - 
to overlap the arc end points (also shown but not editable in the Properties panel).  

And EasyEDA provides a Board outline wizard, so it is very easy to create a board outline.
Via: Tools > Set Board Outline, Or find it on the toolbar.  



In this dialog, there's a choice of 3 types of board outlines, Rectangular , Circular, Round Rect. If 
you need a different more complex board outline, you need to import a DXF file.

Notice：

When generate the Gerber, EasyEDA will show error if the board outline don't close or the 
board outline tracks overlap .  
You can cutout the hole by using the board outline, or use Hole , or Solid Region(Type: 
Board Cutout)  to create the hole instead of using the board outline.
You can right-click track or circle to convert to board coutout.

 

Route Tracks  

Route Tracks  

In the schematic editor, we use Wire or the W  Hotkey to connect Pins, in a similar way in the PCB 
editor, we use Track to connect Pads. Track allows you to draw PCB tracks and can be found on 
the PCB Tools palette or using the W  Hotkey (not T).

Some Tips about Track

1. Single click to start drawing a track. Single click again to pin the track to the canvas and 
continue on from that point. Right click to end a track. Double right-click to exit track mode.
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2. Drawing a track at the same time as using a hotkey(for example hotkey B ) for changing the 
active layer will automatically insert a Via:  

   

If you start drawing a track on the top layer, you will see it drawn in red, then press the B key to 
change to bottom layer and you will see EasyEDA insert a grey via and then the track will 
continue being drawn but now on the bottom layer in blue.

3. Pressing the +  or  -  Hotkeys when drawing the track will change the width of the track on the 
fly. Use the hotkey TAB  to change the track width.

4.  Double clicking on a drawn section of the track will add a new vertex at that point. You can 
drag the vertex to form a new corner. And you can right-click the point and delete it.    

  



5.  Click to select the track and then Click and Drag on a segment of the track to adjust the 
segment between vertices. 

  

6.  Pressing the L  Hotkey when drawing the track will change the track's Route Angle on the fly. 
And you can change Route Angle on the Canvas Attributes of the right panel before the next 
drawing.  
  



7.  You can change inflection direction when routing, just press Space  key.  
  

8. If you want to route a track and use "L", and the then press "+", you will get two different size 
track segment.

9. If you want to create the solder mask for the track, you can use "Expose Copper" when you 
select the track on the right-hand panel. The solder mask will bigger 4mil than the track.

10. And if you want to create the slot hole, you can route a track, and then right-click the "Convert 
to Board Cutout" menu.

11. When click right-click to select a track, one click will select a whole track, and click again, will 
select a track segment.

12. You can make track routing width follow design rule, after enable the design rule option.

13. Right-click the track, you can select the track connection or a whole same net tracks.

Track Length



When a track is selected, you can find its Length attribute in the right panel.  

  

At left-hand Design Manager, click a net, will pop up a dialog to show you this net track 
length.
Click a track, press hotkey H will keep hightlight this track and net, and show this net's 
length.

Delete a Segment from a Track

While routing, if you want to undo previous track path, you can press key "Delete" or 
"Backspace".
Move your mouse to the segment which you want to delete, click it, then hold SHIFT  and 
double click it. the segment will be removed. Or right-click delete the node.

Right-click the track node to delete the track
Click the track, right-click delete it, or press "Delete" key directly.



DRC outline

When you routing a track on the signal layer, you will see an outline around the first track, it is 
the DRC outline, the clearance from outline to the track edge depends on your Design Rule(DRC) 
clearance setting.

Routing Conflict  

When the PCB comes from the schematic converted, the "Routing Conflict - Block" will be opened 
automatically.

At the right-hand attributes panel - others, you can find a "Routing Conflict" option:

Ignore: You can route the track overlap the different net name objects.
Block: If the track net name different with other objects, this track will be blocked when 
routing.
RoundTrack: The track while routing will walk arroud the different net objects.
Push： Doesn't develop yet.

Differential Pair Routing  

EasyEDA provide a easy experience for the differential pair routing.
Via: Topbar - Route - Differential Pair Routing

You must make sure the Differential Pair net names must be XXX_N, XXX_P  or XXX+,XXX- .
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and you need to set Differential Pair net rule at the "Topbar - Tool - Design Rule" first.

How to route Differential Pair:

1.Set the Differential Pair net name as XXX_N, XXX_P  or XXX+,XXX- , and set the rule for the 
Differential Pair net at the "Design Rule"
2.Click the menu Topbar - Route - Differential Pair Routing

3.Click the one pad of the Differential Pair pads
4.Routing

While routing, when change layer, editor will add vias automatically. At present, when the 
differential pair routing stop at the vias, it can not continue again, only can start from the Pad.

Track length Tunning  

You can tunning your track very easy on the editor.

Via: Topbar - Route - Track length Tuning
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How to use:

1.Select the track which is you want to tune
2.Click the menu: Topbar - Route - Track length Tunning

3.Set the parameter, start
4.Left-Click the track where is you want to start, and then move the mouse
5.When the track length close your setting, it will stop tunning.

Cloud Auto Router  
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For some simple or prototype PCBs, you may want to use the auto router function to save time. 
Layout is a time costly and dull job. EasyEDA spends lots of time to provide such a feature and it 
is loved by our users.
Before using the auto router, you need to set the board outline for the PCB.

Steps:

1 Click the the auto router button from the topbar "Topbar > Route > Auto Router"

2 Config the auto router

 After you click that button, you will get a config dialog like in the image below.  

 

In the config dialog, you can set some rules to make the auto router result professional. These 
rule must equalize or more than DRC setting.

General Options  

Unit: The unit follows PCB canvas unit.

Track width: The auto-route track width.

Clearance: The clearance of the objects.

Via Diameter/Via Drill Diameter: The via placing by auto-router. 

Realtime Display: when you select it , the real time routing status will show on.

Router Server: 

Cloud: Using EasyEDA online server.
Local: Using the local auto router server, when you click the Auto Router icon, the 
editor will check the local router server available or not automatically. How to use 
please see as below.
Router Layers: If you want to route inner layer, you have to enable the inner layer first.
Special Nets: For the power supply track, you may want it to be bigger, so you can add 



some special rules. 
Skip Nets:  If you like to keep the a net with no route, you can skip it. For example, if 
you want to use copper area to connect GND  net, you can skip the GND  net. If you want 
to reserve the routed track, you need to select the Skip Routed Nets .

3 Run it

After click the "Run" button , The real time check box will let you see how it is going, but it will 
make the process a little bit slow. 

 

Waiting for a few minutes, after adding bottom and top copper area, you will get a finished PCB 
board.

Local Auto Router  

EasyEDA suggest that using local auto router rather than using the cloud server,  because when 
many users using cloud server, the cloud auto router will fail. Only support 64bit system.

Auto router is not good enough! Suggest routing manually! You can use "RoundTrack(Walk 
Arroud)" option to route tracks, via right-hand panel - Routing Conflict.

For the local auto router, please follow the steps as below:

1.Download the local auto router server. 
EasyEDA：EasyEDA Router.zip(134MB)
Supported OS:

Windows7(x64) or later 64bit Windows
Ubuntu17.04(x64) or other 64bit Linux, Linux recommend Deepin
macOS(x64)   

2.Unzip it to the User folder, such as driver D.

3.Configure the browser. 
Notice: Please use the latest Chrome or Firefox !!!   

1)Chrome 
The Chrome Browser don't need to be configure, If the local auto router is unavailable, 
you have to upgrade Chrome to version 60.0.3112.78 or later.

2)Firefox

1.Type "about:config" into the address bar then press enter.
2.Search and double click the options as below (change the values to "true"):  

network.websocket.allowInsecureFromHTTPS    

security.mixed_content.block_active_content  
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  - 3.Re-open Firefox.   

4.Open the decompress folder, Start local Auto Router(don't need to install, just run it 
and keep the command window open):    

Double click win64.bat  in Windows.
Run sh lin64.sh  on command terminal in Linux. Open the terminal, use the cd  
command to change the directory to the lin64.sh  location, and type sh lin64.sh , 
then enter.
Run sh mac64.sh  on command prompt in MacOS. Open the terminal, use the cd  
command to change the directory to the mac64.sh  location, and type sh mac64.sh , 
then enter.

5.Open the editor, open the PCB, Click the Auto Router** icon at editor to start auto-
router.** 
If the local router server is available, the dialog will tell you. Click the Run button, the dialog 
will show the process.

Tips

Sometimes, if you can't get it done, try the tips below.

Make sure the net of PCB doesn't contain the special charaters, such as  ; ~ \ / [ ] =  etc. the 
chrarter - and _ are supported.
Make sure the board oultine is closed, doesn't has board oultine overlap situation.
Make sure there are no DRC cleance errors (short circuit issue), such as two different 
network pads overlapping, or different net pads in the same location within the footprint.
Make sure no footprint outside the board outline.
Make sure PCB rule doesn't have 3 decimal places, EasyEDA auto router only support 2 
decimal places.
Skip the GND nets, add copper area to GND net.
Use small tracks and small clearance, but make sure the value is more than 6mil.
Route some key tracks manually before auto routing and ignore them when auto routing. 
Add more layers, 4 layers or 6 layers， but that will make the PCB more expensive.
Change the components layout, make them have more space between each other.
Don't make any via/pad/solid region overlap the different net objects.
Use local auto router rather than cloud server.
Tell the error detail to us and download and send your PCB file as EasyEDA Source json file:
https://docs.easyeda.com/en/Export/Export-EasyEDA-Source-File/index.html
to support@easyeda.com.

Some professional people don't like the auto router, because they think auto router is not 
professional, but you can use the auto router to check your placement to check the density of 
your PCB. 

https://docs.easyeda.com/en/Export/Export-EasyEDA-Source-File/index.html
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At present, the auto router is not good enough, suggest routing manually, we will improve it in 
the future.

Copper Area  

Copper Area  

Sometimes you will want to fill in or flood an area with copper(Copper Pour). Normally after 
drawing the copper area, set the net it is to be connected to (floating copper areas are not 
recommended because they can cause EMC and Signal Integrity (SI) problems).

Before using Copper Area, please make sure your PCB has a closed board outline!

Usually this copper area will be connected to a net such as GND or a supply rail. You can draw 
the outline of a flood using the Copper Area button from the PCB Tools palette.

When selecting the copper area outline, you can find its attributes from the right hand 
Properties panels.

Layer: Bottom, Top, Inner1, Inner2, Inner3, Inner4 etc.;

Net: the net that the copper area is connected to;

Name: set a name for it.
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Clearance: clearance of the copper area from other nets and floods;

Pad Connection: direct or spoke (i.e. a cross shaped heat shunt);

Spoke Width: When Pad Connection is Spoke, you can set the Spoke width, which is copper area 
fill connect with Pads.

Keep Island: Yes/No. This keeps or removes any isolated areas of copper created as part of the 
flooding process. It is usually good practice to removes these unless you really need them to 
maintain a more even spread of copper (copper balance) on your PCB.

Fill Style: Solid/No Solid/Grid. Selecting No Solid will removes the fill so that you can see the 
tracks more clearly; when select Grid, you can set the grid spacing and grid width.

Copper to BoardOutline: Setting the clearance between copper with board outline.

Improve Fabrcation: Yes/No. If you set as No, you will see much sharp copper corners, that is 
not good for PCB fabrication.

Rebuild CopperArea: Click the button to Rebuild Copper Area if you make any changes.

Edit Points: You can edit the copper area shape manually, any shap as you want.

Place Vias: When you add copper areas at top and bottom layer and inner layer which are 
having same net, you can add multiple vias for the copper fill area, just click the "Place Via" 
button, then set the via parameter. The vias will avoid the objects if the via conflict the DRC.

Tips:

Hotkey E  to start draw copper area.
Hotkey L  to change drawing type(90 degrees or 45 degrees or Arc)
Hotkey Shift+B  to build all of the copper areas.
Hotkey  Shift+M  to hide copper areas fill zone, just show the copper outline.
Hotkey Delete  or BackSpace  to redo previous steps.
If you after copper pour but no copper show up, you need to set it a net same one of the 
PCB nets, or keep the island as YES, and the rebuild the copper area via "Rebuild Copper 
Area" button or "SHIFT+B".
If you want to hide the copper area and keep routing tracks, you can set the copper zone 
invisible at the right-hand panel.



Notice:

Because of the browser's performance issue, EasyEDA doesn't support the real-time copper pour, after 
PCB modifying, please rebuild copper area via Hotkey Shift+B  .

EasyEDA doesn't support click the copper zone, you need to click the copper outline to select it.

The copper filled data is stored in the client or browser(that is because some copper filled data 
is too large to save at server), and the copper area outline data is stored in the file. Therefore, 
when the PCB is opened for the first time, the copper area filled data will be automatically 
pouring and saving at local, and the second time the PCB is opened, the filled data will be 
automatically loaded from the local storage. When you need to draw the forbidden copper-
laying area, please use the "No Solid" property of "Fill Type" to cutout the copper area and 
rebuild it, do not use the operation of drawing the area with wires or circles and then removing 
the wires or circles to create the forbidden copper pour area.

Copper Area Manager  

EasyEDA support copper area manager now, you can set the copper order and apply, the 
forward copper area will be poured first. 

Via: Topbar - Tools - Copper Area Manager

For example：
The GND on the top and VCC on the top, you can see the clearance is different.
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Solid Region  

EasyEDA has added a new tool Solid Region for PCB design

This is a very useful, quick way to connect Pads. You can draw a Solid Region to include all of 
these pads with same net name, then set the region to the same net name as the pads. It is like 
Copper Area but easier to use for small areas. To use Solid Region like this, set the Type attribute 
(in the right hand Properties panel) to Solid.

When you drawing the solid region, you can use the hotkey L  and space  to change the route 
type(Arc, 90 degrees, 45 degrees, Free Angle), just like the track routing.
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When you finish drawing, you can click the solid region and change its attributes at the right-
hand panel.

Layer: Solid Region su pport many layers, you need to enable the layer at the Layer 
Manager first.

Net: When change to top or bottom or other inner signal layer, the solid region can be set a 
net to connect other objects. Sometimes, you can use solid region to make the copper 
instead of "Copper Area".

Type: Solid,Board Cutout,No Solid ,

Solid: It will fill the solid area.
No Solid: It will cutout the area such as copper area. Notice, if you cutout a copper 
area, the solid region's net must different than copper area's net. After setting to this 
option, you need to rebuild the copper area with SHIFT+B.
Board Cutout: you can use this feature to create a slot hole(Non Plated Through Hole).

Edit Points: You can edit the solid region's outline points as you want.

Expose Copper: ou can create an aperture in the solder mask by one click. It's very easy to 
do.

The outline of the solid region can not be self-intersection, when it happens, please delete the 
self-interation point at "Edit Points".

Distribute Array  

EasyEDA doesn't support the paste array, but EasyEDA provide a powerful function - Distribute 
Array. It works at PCB, Footprint, PCB module.

Via: Topbar - Align - Distribute Array

How to use: Selected the objects - Click the Distribute Array - Set the parameters, and apply.
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Retangular:

Item Rotation: The rotation of the item, if you set 30 degrees, all selected item will rotate 30 
degrees.

Location: The location for the first item to place. on the left-top corner of the items.

Distribute By:

Column: From top to bottom, and then from left to right, like word N.
Row: From left to right, and then from top to bottom, like work Z.

Circular:

Item Rotation: The rotation of the item.
Location: The center location of the circle.
Radius: The radius of the circle.
Start Degree: The start degree of the first item. 0 degree is on the middle of the right side.
Direction: The forward direction of the items. Anti-Clockwise or Clockwise
Spacing(Degrees): The spacing between each item.
Rotate Item to Match: If choose Yes, the item will rotate to match the circle. When setting 
Yes, the item actually rotation will be "Item Rotation + Spacing".

Before Rotate Item to Match:



After Rotate Item to Match:

Teadrop  

Via: Topbar - Tools - Teardrop

You need to set the parameter first, and then Apply.
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When delete the track, the teardrop will be deleted too.

If the teardrop detect the DRC errors while generating, this teardrop will not generate.

At present, doesn't support add teardrops for one part.

In fact, the teardrop is a Solid Region, when you select it, you can modify its attributes.

Design Rule Check(DRC)  

EasyEDA provides a real time DRC(Design Rule Check) function. This is a big feature of EasyEDA. It 
is hard to fix DRC errors after laying out the PCB. Now EasyEDA will let you know the error in 
routing. You will find an X  flag to mark the error.

Design Rule Setting  

Via at:Tools > Design Rule..., or Via: right-click the canvas - Design Rule... to open the Design 
Rule setting dialog:  
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The unit follow the canvas unit.

Rule: The default rule named "Default", you can add the new rule you can rename and set 
parameters for it. Each net can be set a rule.
Track Width: Current rule's track width. The PCB track width can not less than this value.
Clearance: The clearance of different objects which have different net. The clearance of the PCB 
can not less than this value.
Via Diameter: The via diameter of current rule. The via diameter of the PCB can not less than 
this value. Such as the Hole/Multi-layer Pad's diameter.
Via Drill Diameter: The via drill diameter of current rule. The via drill diameter of the PCB can 
not less than this value.
Track Length: All track length of current rule. The length of tracks belong to a same net should 
not be longer than this value.Including the arc lenghth. When the input box is empty the length 
will be unlimited.

Realtime DRC: After enable, when you routing the DRC will checking all the time, when appear 
the error the canvas will show the "X" marking.



Check Object to Copper Area: Check the clearance of the objects to copper area. If you disable 
this option, you must rebuild the copper area before generating the Gerber with SHIFT+B.
Check Object to Board Outline: When you enable, you can set a value to check the clearance of 
the objects to board outline.

Set Rule for a Net  

1. Click the "new" button to create a rule, or use the default rule
2. Select one or more networks on the right, support holding down the CTRL key for multiple 

selection, and also can perform keyword filtering and rule classification filtering
3. Then select the rule you want to set in the "set rules" section below and click the "apply" 

button. The network applies the rule.
4. Click the "Settings" button to apply the rule.

Check the DRC Error  

Via "Design Manager - DRC Error", click the refresh icon to run the DRC. If your PCB is a big file, 
and have the copper area that will take some times to check the DRC, please wait a while.

After checking, you can view all the error at the "DRC Error", click the error the related objects will 
be highlighted.

 

Note: 

When you convert a schematic to PCB, the real time DRC is open. But in the old PCB, the real time 
DRC is closed. you can open it as in the image above. 
Design rule checking can only help you find some obvious errors.
The color of the DRC error can be set in the layer manager.
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Footprint Attributes  

When selecting a Footprint, you can find its attributes at the right hand Properties panel.

Prefix: It is same as the schematic. If you move the prefix too far away from the footprint, it will 
be dragged back to the footprint when you open the PCB again, if you don't need the prefix 
please set the prefix display as No.

Layer: You can set a footrpint to be on the TopLayer or BottomLayer. 
Note: The footprint mirrors when swapping layers.

X-Location and Y-Location: Moves the origin of the footprint to a precise position.

Rotation: Rotates the footprint about its origin over the range from 0o to any angle in 
1o steps (visually of course multiples of 360o will appear identical).

ID: EasyEDA will assign a unique ID for each footprint automatically, you can't modify it.  

 

Change Attributes in Batch on PCB Editor

Sometimes, we need to change some attributes of multiple objects together, such as the track 
width, hole size and font size.
Now, you can select them and do some changes. 

Taking the track for an example. If you select 3 tracks, now you can change their Width , Layer , 
Net  together.  The difference property values will combine as <...> , change it directly will apply 
to all seleted objects.
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Design Manager  

Just like Schematic's Design Manager, PCB's Design Manager can be found via:

Left Navigation panel > Design

or just press the  CTRL+D  hotkey to open the Design Manager dialog.

In this dialog, you can:

1. Click a component to highlight it.
2. Check/uncheck a component to show/hide it.
3. Filter to find a component or net.
4. Click a net to highlight the tracks/vias with the same net.
5. Check/uncheck the net to show/hide the net. For example, very often you may want to use 

this to hide a GND or supply net which has had a copper flood added to turn it into a plane 
and then show it again later.

6. Double click the net to remove all of the tracks and vias with the net name. If you want to 
reroute a net, this is the recommended method to use to un-route it first.
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Import Changes  

Import Changes  

Sometimes, while working on a project, you need to make changes to the schematic and then 
update your board, to incorporate them.

It's easy to do this with EasyEDA.

Go to the PCB Editor, Topbar > Import Changes

Or click that button at the tool bar  

If there are some errors at schematic, such as prefix duplicated, no footprint, it will pop up notice 
dialog, the more information please refer： Schematic - Convert to PCB  
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If no errors, you will get a Confirm Importing changes information dialog:

If you are happy with your changes, just click the Apply Change button.

The changes will then be passed into the PCB layout and you can then adjust the tracking to suit.



Notice: The prefix and name of the footprint on the PCB, must the same as the part's on the 
schematic, otherwise it will be removed and place a new one when Import Changes.

 

Panelize  

via: Topbar - Tools - Panelize

Panelize by Editor  

At present, EasyEDA only support to panelize PCB itself, in order to decrease the file size, the 
panelized file only panelize the board outline. 
Normally, all the PCB factory will support this panelized file, if you not sure, you need to contact 
your PCB factory support.

The Border height can not less then 3mm.

V-cut:
If you choose V-Cut, the editor will add the v-cut indication track on mechanical layer.
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Stamp Hole:

When you preview the Panelize Gerber at JLCPCB.com, you will get the image like below:



JLCPCB will take care of your design, they know how to do.

 

Panelize by Manually  

Process:

1. Select the whole board, hotkey CTRL+A .
2. Copy the whole board by reference point, hotkey CTRL+SHIFT+C .
3. Paste the board via hotkey CTRL+SHIFT+V , this hotkey will keep the prefix and hide the 

ratline layer.
4. Paste repeatly, after finish, rebuild the copper area with SHIFT+B , recommend draw copper 

area at the end.

Notice

If the board contains plane layer, it can not be panelized by manually, it will not generate the 
plane zone as you want.
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Layout a PCB Without Schematic  

 

For some small PCB projects, maybe you don't need a schematic. EasyEDA allows you to lay the 
PCB directly from the PCB Editor.

Start a new PCB and you can add footprints directly from the Footprints from Left Navigation 
Panel Parts and then just track them.  

The PCB created by New PCB menu directly, it will hide the ratline layer defaultly.

For setting pad to pad connections, you can check the above Connect Pad to Pad section.

 

PCB Preview  

2D View  

EasyEDA provide a nice Photo View to help you to check the PCB. 

Via: Topbar - Preview - Photo View.

There is a PhotoView  button on the PCB document toolbar, like in the image below. If you can't 
see this button, try to reload the PCB again.

After converting the PCB to Photo View, you can see the result as in the image below.
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3D View  

After click 3D view menu, the server will generate the 3D view file, when the editor loading finish, 
you will see a pretty cool 3D view.

Change 3D view attributes at the right-hand panel;
Reset the 3D PCB position at the left-bottom corner icon;
Keep left-click and drag the canvas can change the view direction;
Keep right-click and pan can change the 3D PCB position.

3D model view of the component please check "PCB - 3D Model Manager" and "Footprint - 
Import 3D Model" chapter.

 

PCB Information  
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PCB design information can be easily obtained by checking PCB information.

Entry: Top menu - View - PCB Information

Nets shows: routed nets/total nets.

 

                    

PCB Module  

EasyEDA support create the PCB modules, it seems schematic module.

Via: Save as Module and New > PCB Module。
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PCB module save at Libraries > Type: PCB module > Classes: Personal > Created

Notice

PCB module has footprints and tracks, it can't be assigned for the schematic module, when place 
it in the PCB it will be separated and can not correspond with the schematic module, you should 
sdjust it manually.

 

 

Generate Fabrication File(Gerber)  

Generate Fabrication File Gerber  
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When you finish your PCB, you can output the Fabrication Files(gerber file) via: Document > 
Generate Gerber, or by clicking the Generate Gerber button from the toolbar.

After clicking, will open the Gerber generate dialog:

You can calculate the price for the PCB order, click SAVE to CART will go to JLCPCB and add your 
PCB in the cart.

Gerber file name

The generated Gerber file is a compressed footprint. After decompression, you can see the 
following files:

Gerber_BoardOutline.GKO：PCB Border file. The PCB board factory cuts the shape of the 
board according to this document. The groove drawn by the EasyEDA, the solid region(Type: 
NPTH) is reflected in the border file after the Gerber is generated. 
Gerber_TopLayer.GTL：Top side copper layer.
Gerber_BottomLayer.GBL：Bottom side copper layer.
Gerber_Inner1.G1，Gerber_Inner2.G1... ：Inner copper layer.
Gerber_TopSilkLayer.GTO：Top silkscreen.
Gerber_BottomSilkLayer.GBO：Bottom silkscreen.
Gerber_TopSolderMaskLayer.GTS：Top solder mask. The default board is covered with 
green oil, and the elements drawn on this layer correspond to the top layer's area will not 
be covered with oil.



Gerber_BottomSolderMaskLayer.GBS：Bottom solder mask. The default board is covered 
with green oil, and the elements drawn on this layer correspond to the bottom layer's area 
will not be covered with oil.
Gerber_Drill_PTH.DRL：Plated drill through hole layer. This document shows the location of 
the hole where the inner wall needs to be metallized.
Gerber_Drill_NPTH.DRL：Non-Plated drill through hole layer. This document shows the 
location of the hole where the inner wall don't need to be metallized. 
Gerber_TopPasteMaskLayer.GTP：Top Paste Mask, for the stencil.
Gerber_BottomPasteMaskLayer.GBP：Bottom Paste Mask, for the stencil.
ReadOnly.TopAssembly：Top Assembly, read only, doesn't affect the PCB manufacture.
ReadOnly.BottomAssembly：Bottom Assembly, read only, doesn't affect the PCB 
manufacture.
ReadOnly.Mechanical：Record the information on the mechanical layer in the PCB design, 
and only use it for information recording. By default, the shape of the layer is not 
manufactured at the time of production. Some board manufacturers use the mechanical 
layer to make the frame when using Altium file to production. When using Gerber file, it is 
only used for text identification in JLCPCB. For example: process parameters; V cut path etc. 
In EasyEDA, this layer does not affect the shape of the border of the board.

Notice:

Before ordering the PCB, please check the gerber at the Gerber view as below.
The Gerber files are generated by browser, please use the browser inner downloader to 
download!

Gerber View  

Before sending Gerber to the factory, please use gerber viewer to check the Gerber carefully.

local gerber viewer you can use such as: Gerbv, FlatCAM, CAM350, ViewMate, GerberLogix etc.

Gerber viewer recommend Gerbv: 

Project page:http://gerbv.geda-project.org/   
Download: https://sourceforge.net/projects/gerbv/files/

How to use Gerbv:

1.Download Gerber zip file, and download Gerbv, unzip Gerber file and run the Gerbv;
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2.Click the +  button at the Gerbv dialog bottom-left corner, open the gerber folder, select all the 
gerber files, and open.

3.And then zoom, measure, check every layer, check drill holes and location. etc.

FlatCAM is a nice tool too: http://flatcam.org/

FlatCAM lets you take your designs to a CNC router. You can open Gerber, Excellon or G-code, 
edit it or create from scatch, and output G-Code. Isolation routing is one of many tasks that 
FlatCAM is perfect for. It's is open source, written in Python and runs smoothly on most 
platforms. 

Free Online Gerber Viewer:

Recommend：jlcpcb.com
tracespace.io/view
gerber.ucamco.com    

 

Export BOM  

You can export the Bill of Materials (BOM) for the schematic (Document) and PCB，click the top 
toolbar BOM  icon:

After clicking the BOM export option, the dialog below will open.

In this dialog，you can click the pencil icon to assign LCSC part's order code for your 
components.

http://flatcam.org/download
https://jlcpcb.com/quote
https://tracespace.io/view/
https://gerber.ucamco.com/
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After clicking on the assign icon，the components and footprints search dialog will pop up, and 
you can choose which component you want to assign.



When you click the "Order Parts/Check Stock" button, we will help you to list all the components 
of your BOM at LCSC.com(If you haven't login LCSC, you have to login first). If you want to buy the 
components form LCSC, and you just need to put them to the cart and check out.

You can open the BOM in any text editor or spreadsheet.

Notice:

If your project has schematic and PCB, the BOM data will come from schematic; if the 
project only has PCB, the BOM data will come from PCB.
In order to support multiple languages, BOM and coordinate files (CSV file) are UNICODE 
encoded and tab-based. If the CSV file cannot be read by your components vendor or PCB 
manufacturer, please convert the encoding and change the delimiter.
Recommended solution: Save as a new CSV file in Excel or WPS. For example, open a CSV file 
in Excel, click or select: Save As - Other Formats - CSV (Comma Separated) (*. csv).
You can also open the CSV file with any text editor (such as Windows Notepad) and save as 
ANSI or UTF-8 encoding. If necessary, replace all tabs with commas.

 

 

Export Pick and Place File  

In PCB editor, if you want to generate Pick And Place as a CSV file, you can via:   

af://n3446


Document > Export Pick and Place File

When you open the exported CSV file, you can see:

This file support two units "mm" and "mil", it is following the PCB unit setting.

There is an option "Mirror the coordinates of the components on the bottom side(Some SMT 
manufacturer may need it, while JLCPCB does not)", you can check with your SMT manufacturer, 
the mostly SMT manufacturer doesn't need it.

Notice：

In order to support multiple languages, BOM and Pick and Place files (CSV file) are UNICODE 
encoded and tab-based. If the CSV file cannot be read by your components vendor or PCB 
manufacturer, please convert the encoding and change the delimiter.
Recommended solution: Save as a new CSV file in Excel or WPS. For example, open a CSV file 
in Excel, click or select: Save As - Other Formats - CSV (Comma Separated) (*. csv).
You can also open the CSV file with any text editor (such as Windows Notepad) and save as 
ANSI or UTF-8 encoding. If necessary, replace all tabs with commas.

 

How to Order PCB  

Order Parts

1.Finish the schematic and PCB design at EasyEDA.
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2.Open schematic, click "Top menu - Export BOM" button, the BOM dialog will open, click "Order 
Parts/Check Stock" button, will open LCSC.com order page. Check Export BOM

3.Add the parts to the cart, and then submit the payment.

Order PCB

1.Open PCB, click "Top menu - Generate Fabriaction File(Gerber)". Check Generate Fabrication 
File(Gerber) 

2.Before ordering, check the Gerber first:
Gerber Viewer

3.Visit at JLPCB https://jlcpcb.com/quote ,login with EasyEDA accout.

4.Order PCB from EasyEDA editor directly(at Generate) or you can add the Gerber 
file(compressed file, ZIP) on the page and type the order options.

5.If you want to assembly parts, before enable the SMT option, you need to check all your parts 
are using "LCSC Assembled" class libs, and then upload the BOM file and Pick and Place file.

LCSC Assembled Libraries
Export BOM, 
Generate Fabrication File(Gerber) 

7.Save to the Cart, and then submit the payment.

Doesn't support to combine the components order with the PCB order.

More information please refer at: 

How to place an order

How to order a SMT order

How to order a stencil

 

Create The Footprint  

Create The Footprint  

There will be times when you will need a PCB footprint that is not already in the EasyEDA 
libraries.  

Footprint Tool

The process of creating your own Footprints is very similar to how you make symbols for your 
own Schematic Libs.

https://lcsc.com/
https://docs.easyeda.com/en/Schematic/Export-BOM/index.html
https://docs.easyeda.com/en/PCB/Gerber-Generate/index.html
https://docs.easyeda.com/en/PCB/Gerber-Generate/index.html#Gerber-View
https://jlcpcb.com/quote
https://docs.easyeda.com/en/Schematic/Libraries/index.html#Libraries
https://docs.easyeda.com/en/Schematic/Export-BOM/index.html
https://docs.easyeda.com/en/PCB/Gerber-Generate/index.html
https://support.jlcpcb.com/article/21-how-do-i-place-an-order
https://jlcpcb.com/smt-assembly
https://support.jlcpcb.com/article/25-how-to-order-a-stencil
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Footprint Tools almost are the same as PCB tools, just lacking some of the functions.

Create Footprint

Start a new Footprint as shown below or by doing:

Document > New > Footprint

This opens the New Footprint editor.

Drawing Steps

1.Downlod the datasheet which you need to draw the Footprint, such as SOIC-8.Such as PDF：
UC2844BD1R2G

2.Read the datasheet, notice the 0 degree of the Footprint (The 0 degree is the Footprint's 
direction when you placed it on the PCB without rotation), the right 0 degree will helpful for PCB 
SMT.

3.Check the footprint size, pad/pin direction and polarity, and then place the Pads on the canvas. 
You can adjust the pad size base on your real usage situation.  

https://image.easyeda.com/files/ON-Semicon-ON-UC2844BD1R2G_C77262.pdf


Component's pin direction, page 1. 

   

footprint polarity, page 1 and 18.  

  

Depends on page 18, placing one pad on the canvas on the top layer, and then change the 
pad number, size, shape type etc. And then set the coordinate for it, and place the less pads, 
you can use the "Topbar - Align" tools to align the pads to fit the location. If you want to 
move the pad by mouse or direction key by small steps, you can set a new snap size at the 
right-hand panel.  

4.Drawing the Footprint silk screen. And sometimes you can add some marking and text on the 
mechanical or document layer.

Swicthing layer to TopSlikLayer
Using the Track and Arc to draw the silk screen. The editor doesn't support draw the 
retangle silk screen at present.   



5.Filling the footprint title and prefix at the right-hand "Custom Attributes", and then Save. When 
you save it , please fill the tags, description, the description suggesting add the footprint 
datasheet link and footprint size, that can help you or other people to recognize this Footprint 
whether if it can be used for the design. 

6.Use the dimension tool to check the Footprint size, via: Topbar - Tools - Check Dimension.

7.Set the origin. You can via: "Topbar - Place - Set Canvas Origin - By Center of Pads" to set the 
origin.

8.Save.

Then the PCB footprint creating finish .

Notice：

The Origin Point. To simplify rotating your symbols when they are placed into the canvas, 
make sure all of your symbols are created as near as possible centered around that point. 
Suggesting the footprint center to be the origin point. That will helpful to rotation when you 
placing it on the canvas, and help to do the SMT more quickly. 
The pad center suggesting one and more on the grid , avoid when place it on the PCB 
causing the track hard to connect issue.
The pad number can be set as number and alphabet, they must match with the 
SchematicLib's pin number, otherwise the component which was assigned this Footprint will 



alert the error at the footprint manager, and can' not convert the schematic to PCB.
The pad number will increase by placing with mouse, if you copy and paste it, the number 
will not increase.

Others 

It is important to set the right Snap and Grid sizes to ensure that the pads on the finished 
footprint snap exactly to the grid and so connect the nets. For example, if you are creating a 
DIP footprint, set the Grid size to 100mil.

Keep all other shapes such as component outlines and any associated pin identification 
marks or text on the TopSilkLayer. EasyEDA will automatically take care of the actual 
layer assignment when you place the footprint on the PCB.

CTRL+S  to save your footprint designs and you will find them saved into the Libraries > 
Classes: Footprint > Personal > Created section of the left Navigation panel. 

Annular ring of the pad/via is too small, keep the annular ring >= 4mil. In this case, you can 
add a Hole

 

Pad attributes  

You can add pads using the Pads button from the Footprint Tools palette or using the P  hotkey.

After selecting one of the pads, you can view and adjust its attributes in the right hand 
Properties panel.
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Number: Remembering the pin numbers you set in the schematic symbol in your Schematic 
Lib: to connect those schematic symbol pins to the pads in your PCB footprint, the pad numbers 
you set here in the Footprint footprint must be the same.

Shape: Round , Rectangular ,  Oval and Polygon.

EasyEDA supports four shapes: Round  ,  Rectangular  , OVAL  and POLYGON .  

OVAL  PAD will give your more space.   
POLYGON  PAD will let you to create some strange pad.  

Like in the image below, you can edit the PADs points when you select a POLYGON  PAD

Layer: If the pads are part of a SMD footprint, you can set it to Top layer or Bottom layer. For 
through hole components you should set it to Multi-Layer.

Net: You don't need to enter anything here because at present this footprint is not connected to 
anything in a circuit.



Width and Height: When the shape is set to Round, Width will equal Height.

Rotation: Here you can set the Pad's rotation as you want.

Hole(D):  This is the drill hole diameter for a through hole pad. For a SMD Pad, set this to zero.

Center-X and Center-Y: using these two attributes, you can set the pad's position with more 
precision, compared to using the mouse.

Plated： Yes or No. when the pad is multi-layer pad, if it set the plated as no, this pad top side 
and bottom side will not be connected together.

 

Edit Footprints  

Edit Footprint in the Libraries  

When you found a Footprints(footprint) but it can not be satisfied for your design, you can edit it 
to be your personal PCB footprint.

Via Libraries > Type: Footprint > Search Component/Personal/LCSC/System > Select 
footprint > Edit

You can edit the pad size, shape outlines, etc. when you finish and save, it will be saved to your 
personal libraries "Created" and become your personal libraries.

And you can add a tag for your Footprint when you save it:
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Modify the saved Footprint tag: ** Libraries > Type: Footprint > Personal > Select footprint > Right 
Click > Modify**

About the tag suggest that using as below:
Through-Hole:
AXIAL: AXIAL-0.3 etc. 

 RAD：Radial 

 HEADER：Headers, connectors 

 DIP：Dual-In-Line components 

 SDIP：small dual in-line package 

 SIP: single in-line package 

 ZIP: zig-zag in-line package 

 TO-92: Transistor Outline 92 

 TO-220: Transistor Outline 220

Gull-wing：
QFP,MQFP,PQFP: Quad Flat Pack 

 TQFP：Thin Quad Flat Pack 

 VQFP: Very Fine Quad Flat Pack 

 PSOP: Plastic Small Outline Pack 

 SOIC: Small Outline IC, narrow/wide 

 VSSOP,SOIC: Miniature small Outline IC 

 SOD123,SOD323,SOD523: Small Outline Diode 

 SOT23,SOT223,SOT3X3,SOT523,SOT563: Small Outline Transistor 

 TSOT,TSSOP: Thin Small Outline Package 

 SSOP: Shrink Small Outline Package 

 DFN,SON: Dual Flat No-lead 

 QFN: Quad Flat No-lead 

 TQFN: Thin Quad Flat No-lead

J-lead:
SOJ: Small Outline IC, J-lead 

 PLCC: Plastic Leaded Chip Carrier 

 JLCC: J-Lead Chio Carrier



Other:
SMD: Chip resister, Chip capacitor 

 MELF: Metal Electrode Leadless

Edit Footprint in the PCB  

If you want to edit a package(footprint) in the PCB, you can use the Ungroup/Group function 
same as the schematic.

On the PCB Tools palette there is the Group/Ungroup Symbol… button.

This tool is for you to quickly create or edit library symbols.

1. Select a footprint
2. Click the Group/Ungroup Symbol… button

Up to this point you have a collection of separate pads, a drawn silk layer tracks and some 
text that are all separate items with no particular association with each other.

3. Edit the shape or pad what you want to change
4. Select all of the items and click the Group/Ungroup Symbol… button. 

A dialog will be opened:

After you click OK, all those separate elements will be grouped together to form your new symbol 
directly in the PCB.

Using the group function, you can create/edit any symbol in the Schematic/PCB, easily and 
quickly.

 

 

Import PCB 3DLib  

Import 3D File  
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EasyEDA supports for importing 3D models, PCB can view cool 3D models when doing 3D 
preview. Exporting PCB 3D model files is not supported yet.

1. Draw or download 3D model:

Note: currently only 3D models in "WRL(VRML)" and "obj" are supported. WRL can be imported 
directly without the need for compression; Obj must be compressed into a zip file with the MLT 
file and then imported, and the MLT file is usually taken with you when you download the obj file. 
Other formats of 3D files wii be supported in the future.

Note that file suffixes cannot be capitalized.

Download address:

https://library.io/explore/3dmodels    MLT files are automatically downloaded when obj files are 
downloaded.

https://github.com/KiCad/kicad-packages3D  

https://www.traceparts.com/zh

https://www.3dcontentcentral.com/

https://grabcad.com/

2. Create a new 3D library in "Top Meun - New - PCB 3D Lib".

https://library.io/explore/3dmodels
https://github.com/KiCad/kicad-packages3D
https://www.traceparts.com/zh
https://www.3dcontentcentral.com/
https://grabcad.com/


If you have many 3D libraries, you can zip them to a zip file to import, no more than 10 WRL files 
for one zip file, otherwise it will fail to import.

OBJ format contains many 3D models in one file, you don't need to zip them.

3. Import 3D model. You can check which 3D model you want to import.

4. Open the PCB or Footprint

5. Find "Top menu - Tools - 3D Model Manager"

 

6. Specify the imported 3D model for the corresponding footprint, which is basically consistent 
with the footprint manager operation. For the specific use of the tutorial, please see: PCB - 
3D Model Manager

https://docs.easyeda.com/en/PCB/3D-Model-Manager/index.html


7. Adjust the position and parameter relationship between the 3D model and PCB packaging, 
and click update

8. After completing all the specified 3D models, you can start the 3D preview of the whole PCB.

Edit 3D Lib  

1. The SHIFT+F shortcut opens the component library dialog box
2. Switch to "PCB 3D library" and "WorkSpace"
3. Right click can edit and delete 3D library

FAQ：

Q：Can the official footprint library specify the 3D model first?
A：Yes, later official libraries will specify 3D models. At present, you need to specify to PCB or 
PCB footprint.

Q：Can EasyEDA export the whole PCB 3D format for structural design? Step, etc.
A：It will be supported in the future, step by step, and will directly support importing the step 
format in the future. This format is more complicated and needs time to study.
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Q：Will EasyEDA support to draw 3D models in the future?
A：Don't. At present, many 3D rendering tools are very mature (Auto CAD, CAXA, SolidWorks, 
etc.) or open source free (FreeCAD, LibreCAD). Online 3D design tools (onshape) are also 
available.

 

Footprint Naming Rule  

EasyEDA Footprint Naming Rule  

EasyEDA Footprint Naming Rule Reference

Introduction: 

Believe that the vast number of electronic engineers will encounter the problem of footprint 
name naming, and now EasyEDA to provide everyone with a reference scheme - "EasyEDA 
Footprint Naming Rule Reference".

Each company should have its own footprint naming specification,EasyEDA is no exception, 
EasyEDA has more than 180,000 of official library (LCSC library), multiple engineers in the 
construction of footprint, more need unified library rules and footprint naming rules to ensure 
library consistency and footprint reuse.

Written by LCSC engineering department and EasyEDA team, after close one year of running in, 
now we are very happy to release the "EasyEDA Footprint Naming Rule Reference".

EasyEDA has been established according to the new footprint naming specification Footprints for 
more than half a year, and EasyEDA will continue to draw new library according to this rule.

The majority of EasyEDA users can also according to this rule:

1. Find the components of the specified package type;
2. Create your own or team's or company's footprint according to this rule;
3. Quickly reuse the official footprint.

Characteristics:

1. The rules of "package type _ feet number - body width - foot distance - body length - foot 
azimuth - polarity direction _ series name" are adopted in naming, so that users can quickly 
and clearly footprint most of the information

2. It covers most common component classification and encapsulation types and can quickly 
locate and query

3. Continuously expand new naming rules according to new components or packaging types, 
and continuously update and maintain

4. Public distribution, free of charge for both individuals and enterprises

Disadvantages:

Titles of some footprint types are too long

Update record:

2019.12.27 First release

Download:

af://n3661
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Download: EasyEDA Footprint Naming Rule Reference.pdf

 

Import Image  

Import Image to Schematic  

When you select Image from the Drawing Tools palette, an image place holder will be inserted 
into the canvas:

Select the place holder, so you can see the image's attributes in the right hand Properties panel:

Set the URL of your image. For example, setting the URL to:

http://upload.wikimedia.org/wikipedia/commons/thumb/c/c7/555_Pinout.svg/220px-
555_Pinout.svg.png

will make your image look like this:

https://easyeda.com/forum/topic/EasyEDA-Footprint-Naming-Rule-Reference-9b470b52aeca46228b446f1fc0e323f0
af://n3698
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http://upload.wikimedia.org/wikipedia/commons/thumb/c/c7/555_Pinout.svg/220px-555_Pinout.svg.png


Please note: at present, EasyEDA cannot host images, so you need to upload your images to an 
image sharing site such as http://www.imgur.com.

 

Import Image to PCB  

On PCB and Footprint editor, there is a nice feature on the PCB Tools bar.

After clicking on the image icon, you will see the Insert Image window as below.

In this dialog, you can choose your favorite image, EasyEDA support JPG , BMP , PNG , GIF , and 
SVG . Unlike some other EDA tools which only support a Monochrome Bitmap image, EasyEDA 
supports full color, but Monochrome Bitmap is welcome.

You can adjust the color tolerance, simplify level and reset the image size there.

And you can select shape invert. 

http://www.imgur.com/
af://n3711


The image will be inserted to the active layer, if it is not right, you can change the attribute. Such 
as TopSilkLayer.  

Import DXF File  

 

How to create irregular board outlines or complex board outline in EasyEDA? 
This is sometimes needed when you are designing a PCB for an enclosure that may have a 
curved profile, or other unavoidable mechanical features for which one must design.  

EasyEDA support that import DXF into PCB.

Find the import DXF menu under the file menu.

 

af://n3722


After selecting the *.DXF file, you will find a dialog like in the image below

EasyEDA provides two options, unit(mm, cm, mil, inch), and select the layer to which the shapes 
will be applied.

After clicking the import button, you will find them on your PCB canvas.



You can try this to import this example by yourself. DXF example  

Please note:  

1. The file must have a *.dxf filename extension  
2. The circles will be converted to holes if you choose the layer as board outline.  
3. There are some items which are not supported.  

Import Altium Designer  

The import function is beta now, please check carefully after imported.

Some design rules EasyEDA doesn't support yet.

Import Schematic and PCB  

1. You can import Altium Designer's Schematic and PCB files into EasyEDA but only 
from ASCII files, so you need to save the designs as Ascii files like this.

https://image.easyeda.com/files/test.dxf
af://n3743
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Then import it via:

EasyEDA offers an excellent experience in importing Alitum Designer's Schematic and PCB as you 
can see from the image below of a schematic imported from Altium Designer:



If your schematic and PCB are Protel 99se format files, please open at Altium Designer and save 
as ASCII format, and then import them. EasyEDA don't support Protel 99se file format directly.

2. If you import Altium schematic found some text became unreachable code, please encode 
your ASCII file with UTF-8. 

Notice:

EasyEDA doesn't sopport to import the Alitum PCB rules now.
EasyEDA doesn't sopport to import the Alitum PCB inner plane layer, please modify 
manually after imported.
EasyEDA doesn't sopport to import the Alitum IEEE symbol of the schematic now.

Please do not export your design to Alitum and import it again and again, that will cause 
some detail missing!!!

Import Altium libraries  

Altium Designer's Schematic and Footprintraries are not available as ASCII files, EasyEDA can't 
import them directly, so how can you import them?

af://n3771


In the Import file from your computer dialog to the right of File Operation; tick the Extract 
Libs  option and EasyEDA will extract all of the libs from the Schematic files or PCB Files. 

So, if you want to import Altium Designer's Libs, you can add them to your Altium Designer 
Schematic or PCB and then extract them again into your EasyEDA library.

Import Eagle  

Please refer next section

Import KiCAD  

Please refer next section

Import Eagle  

Eagle Schematic/PCB/libs can be imported, but EasyEDA can only support version 6 and later (6+) 
because that was when Version 6 Eagle adopted an ASCII XML data structure as their native file 
format.

af://n3776
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If your Eagle file can be open in Eagle, but can't be imported in EasyEDA, you can save as a copy 
with the latest Eagle, and then import this one.

 

Import KiCAD  

EasyEDA support import KiCAD v4.06 and greater version KiCAD files, if the KiCAD files version 
less then v4.06, please open them at the latest KiCAD and save as a new one, and then import 
them.
The KiCAD file needs to be compressed as zip file before import.

The zip file must contain:

Schematic and PCB
Libraries files and folder
others related files

    
if you compress the whole project will be better.

af://n3790


Export BOM  

You can export the Bill of Materials (BOM) for the schematic (Document) and PCB，click the top 
toolbar BOM  icon:

After clicking the BOM export option, the dialog below will open.

In this dialog，you can click the pencil icon to assign LCSC part's order code for your 
components.

After clicking on the assign icon，the components and footprints search dialog will pop up, and 
you can choose which component you want to assign.

af://n3806


When you click the "Order Parts/Check Stock" button, we will help you to list all the components 
of your BOM at LCSC.com(If you haven't login LCSC, you have to login first). If you want to buy the 
components form LCSC, and you just need to put them to the cart and check out.

You can open the BOM in any text editor or spreadsheet.

Notice:

If your project has schematic and PCB, the BOM data will come from schematic; if the 
project only has PCB, the BOM data will come from PCB.
In order to support multiple languages, BOM and coordinate files (CSV file) are UNICODE 
encoded and tab-based. If the CSV file cannot be read by your components vendor or PCB 
manufacturer, please convert the encoding and change the delimiter.
Recommended solution: Save as a new CSV file in Excel or WPS. For example, open a CSV file 
in Excel, click or select: Save As - Other Formats - CSV (Comma Separated) (*. csv).
You can also open the CSV file with any text editor (such as Windows Notepad) and save as 
ANSI or UTF-8 encoding. If necessary, replace all tabs with commas.

 

 

Export NetList  

EasyEDA can export the netlist for the whole active project:

Document > Export NetList > Spice...

EasyEDA can export a netlist in a variety of formats: 

af://n3829


Spice: this is a Spice3f5 compatible netlist generated by the simulation engine of EasyEDA, 
Ngspice. It is not normally used as the basis for as a PCB layout.
Altium Designer: a PCB netlist in a format that can be imported straight into Altium 
Designer and it's predecessor, Protel. 
Pads: a PCB netlist in a format that can be imported straight into Pads PCB layout tools.
FreePCB: a PCB netlist in a format that can be imported straight into FreePCB, a  free, open 
source PCB editor for Windows.

Export PCB  

Export PCB in PDF/PNG/SVG  

Exporting a PCB design or footprints from EasyEDA is very similar to exporting a Schematic or a 
Symbol.

Via: Document > Export > PDF/PNG/SVG…

http://www.google.com/url?q=http%3A%2F%2Fngspice.sourceforge.net%2Fpresentation.html&sa=D&sntz=1&usg=AFQjCNEvVOggHskD819G-5EW8EB59FL5mw
af://n3847
af://n3850


You will open this dialog:

You can select to export in PDF, PNG or SVG format.



Note: *The PDF size is zoom as 1:1 with PCB. *

Export to: Support export to PDF, PNG, SVG. If you want to print the PCB 1:1, please choose 
PDF.

Engine:

Local: PDF generated by Editor
Cloud: PDF generated by Cloud Server, in the future, EasyEDA will remove this option.

Graphics:

Full Graphics: All graphics, objects will be exported. 

Assembley Drawings: Only exporting components's prefix and location, hole etc. This 
is for part assembly. 



Object Outline: Only exporting objects' outline, such as Pad and silkscreen outline.

Type:

Merged layer: All selected layers you want to export will be merged in one page.
Paged layer: All selected layers you want to export will be paged in one file.
Separated layer: All selected layers you want to export will be separated in multiple 
files. Export as a ZIP file.

Color: You can choose "Black on White", "White on Black", "Full Color".

Layer: You can select to print individual layers or selected layers merged into a single file.

Mirror: It is also possible to mirror selected layers for example to show bottom layers in 
easily readable orientation. Recommend when all your selected layers are bottom type you 
can enable this option.

If EasyEDA PDF can not satisfy your requirement, please let us know support@easyeda.com

And if you generated the Gerber file, you can use the Gerbv to export the PDF, it is very easy.

Via Gerbv

 

Export PCB in Altium Designer Format  

The more information please refer at Export Altium

Download PCB  

Please refer at Export EasyEDA Source

Print PCB and Etching  

EasyEDA doesn't support to print PCB directly, please export PDF and print.

If you don't want to order your PCBs from EasyEDA then maybe - for single and double sided PCB 
designs -  you might like to try like using some home made PCB tech:

http://hackaday.com/2012/12/10/10-ways-to-etch-pcbs-at-home/

So here's how you can print your PCB layer by layer and then etch it onto a PCB.

https://docs.easyeda.com/en/Export/Export-Gerber-Files/index.html#Gerber-View
af://n3896
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af://n3902
http://hackaday.com/2012/12/10/10-ways-to-etch-pcbs-at-home/


Step 1) Export it to PDF, Using: Document > Export > PDF…

Note: Make sure the Colour is Black on White Background.

Generally choose the bottom layer. Select if you want to mirror the export as needed.

If you have routed PCB tracks on the top layer, then you need to choose the top layer. Etch PCB 
by themselves generally need to mirror export printing.

Step 2) Open the pdf file in a viewer



Step 3) Print it to paper

Step 4) Copy it to the copper

Step 5) Etch it

Step 6) Drill it

Step 7) Get your soldering iron out!



 

 

Generate Fabrication File(Gerber)  

Generate Fabrication File Gerber  

When you finish your PCB, you can output the Fabrication Files(gerber file) via: Document > 
Generate Gerber, or by clicking the Generate Gerber button from the toolbar.

After clicking, will open the Gerber generate dialog:

af://n3927
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You can calculate the price for the PCB order, click SAVE to CART will go to JLCPCB and add your 
PCB in the cart.

Gerber file name

The generated Gerber file is a compressed footprint. After decompression, you can see the 
following files:

Gerber_BoardOutline.GKO：PCB Border file. The PCB board factory cuts the shape of the 
board according to this document. The groove drawn by the EasyEDA, the solid region(Type: 
NPTH) is reflected in the border file after the Gerber is generated. 
Gerber_TopLayer.GTL：Top side copper layer.
Gerber_BottomLayer.GBL：Bottom side copper layer.
Gerber_Inner1.G1，Gerber_Inner2.G1... ：Inner copper layer.
Gerber_TopSilkLayer.GTO：Top silkscreen.
Gerber_BottomSilkLayer.GBO：Bottom silkscreen.
Gerber_TopSolderMaskLayer.GTS：Top solder mask. The default board is covered with 
green oil, and the elements drawn on this layer correspond to the top layer's area will not 
be covered with oil.
Gerber_BottomSolderMaskLayer.GBS：Bottom solder mask. The default board is covered 
with green oil, and the elements drawn on this layer correspond to the bottom layer's area 
will not be covered with oil.
Gerber_Drill_PTH.DRL：Plated drill through hole layer. This document shows the location of 
the hole where the inner wall needs to be metallized.
Gerber_Drill_NPTH.DRL：Non-Plated drill through hole layer. This document shows the 
location of the hole where the inner wall don't need to be metallized. 
Gerber_TopPasteMaskLayer.GTP：Top Paste Mask, for the stencil.
Gerber_BottomPasteMaskLayer.GBP：Bottom Paste Mask, for the stencil.
ReadOnly.TopAssembly：Top Assembly, read only, doesn't affect the PCB manufacture.
ReadOnly.BottomAssembly：Bottom Assembly, read only, doesn't affect the PCB 
manufacture.
ReadOnly.Mechanical：Record the information on the mechanical layer in the PCB design, 
and only use it for information recording. By default, the shape of the layer is not 
manufactured at the time of production. Some board manufacturers use the mechanical 



layer to make the frame when using Altium file to production. When using Gerber file, it is 
only used for text identification in JLCPCB. For example: process parameters; V cut path etc. 
In EasyEDA, this layer does not affect the shape of the border of the board.

Notice:

Before ordering the PCB, please check the gerber at the Gerber view as below.
The Gerber files are generated by browser, please use the browser inner downloader to 
download!

Gerber View  

Before sending Gerber to the factory, please use gerber viewer to check the Gerber carefully.

local gerber viewer you can use such as: Gerbv, FlatCAM, CAM350, ViewMate, GerberLogix etc.

Gerber viewer recommend Gerbv: 

Project page:http://gerbv.geda-project.org/   
Download: https://sourceforge.net/projects/gerbv/files/

How to use Gerbv:

1.Download Gerber zip file, and download Gerbv, unzip Gerber file and run the Gerbv;

2.Click the +  button at the Gerbv dialog bottom-left corner, open the gerber folder, select all the 
gerber files, and open.

3.And then zoom, measure, check every layer, check drill holes and location. etc.

FlatCAM is a nice tool too: http://flatcam.org/

FlatCAM lets you take your designs to a CNC router. You can open Gerber, Excellon or G-code, 
edit it or create from scatch, and output G-Code. Isolation routing is one of many tasks that 
FlatCAM is perfect for. It's is open source, written in Python and runs smoothly on most 
platforms. 

Free Online Gerber Viewer:

af://n3975
http://gerbv.geda-project.org/
https://sourceforge.net/projects/gerbv/files/latest/download?source=files
http://flatcam.org/download


Recommend：jlcpcb.com
tracespace.io/view
gerber.ucamco.com    

 

Export Pick and Place File  

In PCB editor, if you want to generate Pick And Place as a CSV file, you can via:   

Document > Export Pick and Place File

When you open the exported CSV file, you can see:

This file support two units "mm" and "mil", it is following the PCB unit setting.

There is an option "Mirror the coordinates of the components on the bottom side(Some SMT 
manufacturer may need it, while JLCPCB does not)", you can check with your SMT manufacturer, 
the mostly SMT manufacturer doesn't need it.

Notice：

In order to support multiple languages, BOM and Pick and Place files (CSV file) are UNICODE 
encoded and tab-based. If the CSV file cannot be read by your components vendor or PCB 
manufacturer, please convert the encoding and change the delimiter.
Recommended solution: Save as a new CSV file in Excel or WPS. For example, open a CSV file 
in Excel, click or select: Save As - Other Formats - CSV (Comma Separated) (*. csv).
You can also open the CSV file with any text editor (such as Windows Notepad) and save as 
ANSI or UTF-8 encoding. If necessary, replace all tabs with commas.

https://jlcpcb.com/quote
https://tracespace.io/view/
https://gerber.ucamco.com/
af://n3997


 

Export DXF  

EasyEDA support to export PCB to DXF.

At present only support Board Outline, Hole, NPTH, PTH. 

If you want to export track and silkscreen, please try to export PDF. And CAD application convert 
PDF to DXF.

Export Altium Designer Format  

EasyEDA support exporting the schematics and PCB in Altium Designer format.

The "export to Altium" function is beta now, Please check carefully after exported the 
design to Altium, EasyEDA cannot guarantee that is no errors!!! EasyEDA does not bear any 
loss due to library errors and format conversion!!! If you do not agree, please do not carry 
out Altium export!!!
If you want to order the PCB please generate the Gerber instead of exporting to Altium!
Please do not export your design to Alitum and import it again and again, that will cause 
some details missing!!!
Doesn't support Alitum 19 yet, please open exported file at Altium 18 and less, recommend 
Altium 17

If you find out some incorrect detail, please contact us support@easyeda.com  to fix, including 
detail and files.

When exporting, you don't need to save document at firstly, but you need to login.

Exporting Schematics In Altium Designer Format  

af://n4014
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EasyEDA support exporting the schematics in Altium Designer format.
Via "Documents > Export > Altium...", and click the "Download" you will get  a  .schdoc  file.

 

Exporting PCB in Altium Designer Format  

EasyEDA support exporting the PCB in Altium Designer format.
Via "Documents > Export > Altium..." you will get  a  .pcbdoc  file.

When open the exported PCB file at Altium Designer, there will open a dialog of DXP Import 
Wizard, don't worry, just cancel it to continue.

af://n4033


Known Issue:

1. No Copper Area fill data.
And then, you will see the PCB file, which is looks like without copper area as below:

You need to repour all polygons at Altium Designer. Via: Tools > Polygon Pours > Repour 
All:



 

And the last, save it. 

2. No Ratlines.



If you export the PCB without ratlines, you need to show all connections first before routing :
Via: Design > Netlist > Clean All Nets (D > N > A),and then (V > C > S)

Or use hotkey: N > H > A and then N > S > A:  

3. Inner layer Plane Zone doesn't export perfectly.

You need to rebuild the plane zone, and re-assgin plane zone's net.

4. Doesn't support DRC rule.

Please check the DRC manually.

5. The text may be changed.

Because of the font family, some text maybe will change the position. And it maybe will display 
incorrect, please modify the text manually.

 

Exporting Footprint and Symbol in Altium Designer
Format

 

EasyEDA don't support to export the Symbol or Footprint as Altium Designer library format, but 
you can place the libraries to the schematic or PCB, and export that in Altium Designer format, 
and then extract the libraries at Altium Designer.
EasyEDA does not bear any loss due to library errors and format conversion!!! If you do not 
agree, please do not carry out Altium export!!!

 

 

af://n4059
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Export SVG Source  

EasyEDA support to export or edit SVG source.

You can create an SVG source file via: 

Document > Export > SVG source...

then copy the contents of this box into a text editor and save the file with a .svg extension. You 
can edit it in Inkscape or open it in your browser.

This solution doesn't need an Internet connection you can use it off-line on EasyEDA.

Export EasyEDA Source  

EasyEDA support you save your file to local, you can download your design as EasyEDA source 
file.

1. Export EasyEDA document directly

You can create an EasyEDA source file via: 

Topmenu > Document > EasyEDA File Source...

af://n4066
http://www.inkscape.org/
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2. Download the project

Via： Project folder > Right Click > Download, you will download a zip file with EasyEDA Source 
files for Schematics and PCBs.

Or you can backup the projects, via: Project folder > Right Click > Backup Project



it will open a dialog, you can select the projects what you want to backup. There is only backup 
projects once per day.

EasyEDA Source File is a JSON file which can be read by many other programs. JSON format 
please see:

http://en.wikipedia.org/wiki/JSON

3. Open EasyEDA File

If you want to open the EasyEDA file you exported, you can try: "Top Menu - Document - Open - 
EasyEDA...".

Then you can edit and save the document.

---�

http://en.wikipedia.org/wiki/JSON
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